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Compliance Statements

FEDERAL COMMUNICATIONS COMMISSION INTERFERENCE
STATEMENT

This equipment has been tested and found to comply with the limits for a Class
A digital device, pursuant to Part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against harmful interference when
the equipment is operated in a commercial environment. This equipment
generates, uses, and can radiate radio frequency energy and, if not installed and
used in accordance with the instruction manual, may cause harmful
interference to radio communications. Operation of this equipment in a
residential area is likely to cause harmful interference in which case the user
will be required to correct the interference at his own expense.

The device complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) this device may not cause harmful interference,
and (2) this device must accept any interference received, including
interference that may cause undesired operation.

FCC Caution
Any changes or modifications not expressly approved by the party responsible
for compliance could void the user's authority to operate this equipment.

Warning
Operation of this equipment in a residential environment could cause radio
interference.

Achtung
Der Gebrauch dieses Gerits in Wohnumgebung kann Funkstdrungen
verursachen.

cere 20 & ER

E3914

KCC Statement

'ﬁ'ﬂﬂ‘f‘l"ﬁ'ﬁ 7]7]{ _'__g_ :'c}-drl_/]._']?]]
8] 7|71 = D,jl?_%(g ) ,q? FHEg7) 7] 2 - Bof A =
Ao Zo|&la) 7] ulabe | b 99 A @ o] 4 ALEE}

1.'5=I'I-]__'I rl ]

r||‘|r|
priy
fife >,




ATEN Control System User Manual

Industry Canada Statement
This Class A digital apparatus complies with Canadian ICES-003.

CAN ICES-003 (A) / NMB-003 (A)

RoHS
This product is RoHS compliant.
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About this Manual

This user manual is provided to help you get the most from your ATEN Control
System. It covers all aspects of installation, configuration, and operation of the
ATEN controllers, configuration software, and their accessories, including:

Product Category Model Number Description
ATEN Control Box VK1100 ATEN Compact Control Box
Controllers VK2100 ATEN Control Box

VK1200 ATEN Compact Control Box Gen. 2

VK2200 ATEN Control Box Gen. 2

ATEN Control Pad VKO0100 8-Button Control Pad (US, 1 Gang)
VK0200 12-Button Control Pad (EU, 2 Gang)
Control ATEN Keypad VK108US 8-Button Keypad (US, 1 Gang)
Interfaces VK112EU 12-Button Keypad (EU, 2 Gang)
ATEN Touch Panel VK330 10.1” Touch Panel
VK224 4-Port Serial Expansion
ATEN Expansion Box VK236 6-Port IR/Serial Expansion Box
VK248 8-Channel Relay Expansion Box
VK258 8-Channel Digital /0O Expansion Box
Software | ATEN Configurator VK6000 An application used for creating and

configuring control system projects, control
functions, and visual design of control
interfaces (Viewers).

Database Generator - A repository used for creating and storing
drivers and operation commands of
controlled devices for reuse when
configuring Viewers using ATEN

Configurator.

ControlAssist - An application installed at a PC for it to be

remotely control by ATEN Control System.

Control System App - An application used on mobile devices for

centralized control of multiple rooms.
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An overview of the information found in the manual is provided below.
Chapter 1, Introduction

Introduces you to the ATEN Control System, its purpose, features, and
benefits, and the panel components of the Control Box and Control Pad.

Chapter 2, Hardware Setup

Provides the necessary steps to set up the ATEN Control System, including the
detailed wiring of the different types of hardware interface connections.

Chapter 3, Browser Operation

Provides information about the Control Box’s and Control Pad’s web interface
and its functions for remotely configuring specific parts of the ATEN Control
System.

Chapter 4, ATEN Configurator (VK6000)

Provides a complete description of the ATEN Configurator (VK6000) software
and its configuration / operation features for managing the ATEN Control Sys-
tem.

Chapter 5, ATEN Database Generator

Provides a complete description of the Database Generator software and its
functions for adding new devices to the VK6000 device library.

Chapter 6, Remote PC Control

Explains how to set up your computer as a licensed device for remote control
and the control actions supported.

Chapter 7, ATEN Control System App

Provides a complete description of the ATEN mobile app, the license required,
and its functions and features for remotely operating devices connected to the
ATEN Control System.

Appendix

Provides specifications and other technical information regarding the ATEN
Control System.
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Conventions

This manual uses the following conventions:

Monospaced

[]

A

Terminology

Indicates text that you should key in.

Indicates keys you should press. For example, [Enter] means to
press the Enter key. If keys need to be chorded, they appear
together in the same bracket with a plus sign between them:
[CtrI+Alt].

Numbered lists represent procedures with sequential steps.
Bullet lists provide information, but do not involve sequential steps.

Indicates consecutive selecting options (such as on a menu or
dialog box). For example, Start > Run means to open the Start
menu, and then select Run.

Indicates critical information.

Terminology

Description

ATEN Controller,
controller

ATEN Controller or controller refers to all models of ATEN Control
Box (VK1100 / VK1200 and VK2100 / VK2200) and ATEN
Control Pad (VK0100 and VK0200).

ATEN Control Box,

Control Box

ATEN Control Box or Control Box refers to all models of ATEN
Control Box, including the VK2100 / VK2200 Control Box and the
VK1100 / VK1200 Compact Control Box (Gen. 1 & 2).

Viewer

A Viewer is a software control interface users customize to
control and operate devices in their control system. A Viewer is
configurable using ATEN Configurator and applied to a supported
control device, such as a mobile device, ATEN Keypad, or ATEN
Control Pad, for it to function.

Project

A project is a set of configurations for an ATEN Control System,
including configurations of one or more controllers and managed
devices.

Vi
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Package Contents

The standard package contents of each VK device are described below:

VK0100

*

*

*

*

*

1 VKO0100 8-Button Control Pad
1 button pack

6 terminal blocks

1 faceplate

1 user instructions*

VK0200

*

*

*

*

*

1 VKO0200 12-Button Control Pad
1 button pack

6 terminal blocks

1 faceplate

1 user instructions*

VK1100

*

*

*

*

1 VK1100 Compact Control Box
4 terminal blocks
1 power cord

1 user instructions*

VK1200

*

*

1 VK1200 Compact Control Box Gen. 2
10 terminal blocks

1 power cord

1 foot pad set (4 pcs)

1 user instructions*

VK2100

*

*

*

1 VK2100 Control Box
1 rack mount kit

9 terminal blocks

Vi
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¢ 1 power cord

* | user instructions*

VK2200

+ 1 VK2200 Control Box Gen. 2
¢ 1 rack mount kit

¢ 30 terminal blocks

¢ 1 power cord

+ 1 foot pad set (4 pcs)

* | user instructions*

VK112EU

¢ 1 VKI112EU 12-Button Keypad
. button pack
. terminal block

*

1
1
1 faceplate
1

. user instructions*®

VK108US
¢+ 1 VKI108US 8-Button Keypad

. button pack

1
+ 1 terminal block
¢ 1 faceplate
1

. user instructions*

VK224
VK224 4-Port Serial Expansion Box

power adapter

*
*

. mounting kit

S SN

. user instructions*®

VK236
¢ 1 VK236 6-Port IR / Serial Expansion Box

¢ 1 mounting kit

viii
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+ 6 terminal blocks

* | user instructions*

VK248

¢ 1 VK248 8-Channel Relay Expansion Box
¢ 1 mounting kit
¢ 9 terminal blocks

* | user instructions*

VK258
1 VK258 8-Channel Digital I/0O Expansion Box

¢ 1 mounting kit

*

*

9 terminal blocks

* 1 user instructions*

VK330
¢ 1 VK330 10.1” Touch Panel

* | user instructions*

Note:

¢ Read this manual thoroughly and follow the installation and operation
procedures carefully to prevent any damage to the VK Series devices and
other connected devices.

* New features may have been added after the release of this manual. For an
up-to-date user manual, visit: http://www.aten.com/global/en/
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Product Information

For information about all ATEN products and how they can help you connect
without limits, visit ATEN on the Web or contact an ATEN Authorized
Reseller. Visit ATEN on the Web for a list of locations and telephone numbers:

International http://www.aten.com

North America http://www.aten-usa.com

User Information

Online Registration
Be sure to register your product at our online support center:

International | http://eservice.aten.com

Telephone Support

For telephone support, call this number:

International 886-2-8692-699

China 86-400-810-0-810

Japan 81-3-61-811

Korea 82-2-467-6789

North America 1-888-999-ATEN ext 4988
1-949-428-1111

User Notice

All information, documentation, and specifications contained in this manual
are subject to change without prior notification by the manufacturer. The
manufacturer makes no representations or warranties, either expressed or
implied, with respect to the contents hereof and specifically disclaims any
warranties as to merchantability or fitness for any particular purpose. Any of
the manufacturer's software described in this manual is sold or licensed as is.
Should the programs prove defective following their purchase, the buyer (and
not the manufacturer, its distributor, or its dealer), assumes the entire cost of all
necessary servicing, repair and any incidental or consequential damages
resulting from any defect in the software.
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The manufacturer of this system is not responsible for any radio and/or TV
interference caused by unauthorized modifications to this device. It is the
responsibility of the user to correct such interference.

The manufacturer is not responsible for any damage incurred in the operation
of this system if the correct operational voltage setting was not selected prior
to operation. PLEASE VERIFY THAT THE VOLTAGE SETTING IS
CORRECT BEFORE USE.

Xi
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Chapter 1. Introduction

Chapter 1
Introduction

Overview

The ATEN Control System is an Ethernet-based management system that
incorporates ATEN controllers (ATEN Control Box and/or ATEN Control
Pad) and control interfaces (ATEN Keypads and ATEN Touch Panel) for
connection, configuration, and operation of all hardware devices in a room or
large facility to provide convenient control effortlessly via a mobile device or
an ATEN Touch Panel. The ATEN controller works as the main controller that
provides connectivity to hardware devices commonly seen in settings such
asmeeting rooms, conferences, boardrooms, and classrooms.

After connecting the hardware, the ATEN Configurator (VK6000) provides
simple setup of the devices with easy step-by-step configuration. The ATEN
Touch Panel and ATEN Control System app, for i0OS, Android or Windows
mobile devices, then empowers you with the mobility to control all hardware
devices remotely, whenever and however you like.

ATEN Control Box/Control Pad can be easily deployed into an existing
installation and integrate seamlessly with ATEN VanCryst pro-AV products
and nearly any other hardware devices found in a room, including AV
equipment, lighting, conference systems, air conditioning, motion sensors,
power switches and many more. The controller serves as the central platform
where hardware devices are connected — to be monitored, managed, and
controlled directly via a tailor-made GUI — a Viewer — from any iOS,
Android, or Windows mobile device or an ATEN Touch Panel.

The control system project and its control interface is configured using an
intuitive program — the ATEN Configurator (VK6000). The ATEN
Configurator walks you through configuring the hardware, designing the
control interface (Viewer), and uploading this configuration to the controller.
Through an Ethernet connection, the ATEN Control System app enables you
to edit and download Viewers from the controller via a point-n-tap user
interface. The use of each Viewer is protected with password authentication to
ensure secure access.
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The ATEN Control System is the perfect solution for any meeting rooms,
conferences, boardrooms, classrooms, and any other room setting that requires
a centralized, mobile control of a variety of hardware devices through
streamlined Ethernet-based management system with optimum efficiency and
performance.
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Benefits

Intelligent Control

The ATEN Control System makes the interactions between your hardware
devices smarter. Programmable actions and triggers provide a fully automated
series of advanced operations that allow your devices to respond to each other
intelligently, making your meeting solution run smarter and smoother.

Optimized Performance
The ATEN Control System offers communication protocol optimization that
not only maintains a near-zero response time but also features data encryption

for ensured protection.

Simplified Setup
No matter how large the room or how complicated the hardware, the ATEN
Control System can be deployed in 3 easy steps: connecting the hardware,

configuring the system, and uploading Viewers for remote control access.
Through an intuitive GUI, the process for setting up the controls for every room
is simple and customizable, which is fulfilled via straightforward, predefined
commands and macros that do not require programming skills.

Effortless Expandability
With a range of expansion boxes available, the ATEN Control System
installation can be expanded to accommodate additional hardware devices with

various interfaces, such as serial, relay, and IR. In addition, the ATEN Library
is preloaded with 10,000+ device drivers, and can also be expanded freely by
adding new device drivers through the Database Generator for convenient
management, however the size or scope of the installation may be.

User-Oriented Convenience

With its advanced, single-software design, the ATEN Control System offers a
comprehensive library of actions and design elements for creating intuitive
control panel interfaces for convenient, customizable remote access and
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control by any mobile device. Various support services also provided with the
solution include driver downloads, database generation, upgrade tools, etc. —
to help system integrators build easy-to-control applications in a wide range of
scenarios effortlessly.

On-the-Go Control

Intuitive system control can start from one room and scale up to multiple

rooms, both within the same area and even across regions. Different rooms can
be effectively controlled by switching between Viewers, with simple point-n-
tap operations, on an i0S, Android and/or Windows mobile. For optimal
flexibility, multiple mobile devices can be authorized to control the same room
or multiple rooms, providing enhanced mobility.
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Features

Controller

ATEN Control Box

+ Supports various connection interfaces:

Interface VK1100 VK1200 VK2100 VK2200
Serial Port 2 2 6 8
IR/Serial

Port 2 2 4 8

Relay

Channel 4 4 4 8

1/0 Channel N/A 2 4 8
Ethernet 1 1 LAN 1 1 LAN
Port 1 Control LAN 1 Control LAN

+ DC outputs for power supply connections

+ VKI1100/VK1200: equipped with 1 DC output
+ VK2100/VK2200: equipped with 4 DC outputs
+ 1 x USB port for easy Viewer upload

¢ IR Learning function for adding IR device drivers

+ Supports native KNX IP for building management systems

¢ Telnet, TCP, UDP, ONVIF, PJLink, HTTP, and HTTPS compliant

* Supports project file backup

* Supports up to 8 ATEN Keypads

*  Web GUI for easy system configuration

+ 2 free licenses for mobile control*

* Supports SSH communication for data monitoring

+ Rack-mountable

Note: If you need more than two licenses for mobile control, contact your

local sales representative.
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ATEN Control Pad

*

Supports various connection interfaces:
¢ 2 RS-232 serial ports

¢ 2 relay channels

+ 1 digital input port

¢ 1 Ethernet port

Designed to mount in 2-gang EU type and MK type junction boxes (for
VK0200)

Fully customizable layout

+ VKO0100: 14 layout variations using 4 to 8 buttons

¢ VKO0200: 125 layout variations using 6 to 12 buttons
Customizable button text engraving service

System LED indicators for quick connection status check
Dual-color LEDs for clear indication in dark environments
Redundant power supplies (DC power and PoE)

Supports native KNX IP for building management systems
Telnet, TCP, UDP, ONVIF, PJLink, HTTP, and HTTPS compliant
Supports project file backup

Web GUI for easy system configuration

Supports SSH communication for data monitoring

Note: To control your setup using a mobile device, contact your local sales

representative to purchase licenses for mobile control.
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ATEN Configurator

*

*

*

Simple Viewer setup with easy configuration steps via intuitive GUI
Customizable GUI to be used on mobile devices and PC

Supports ControlAssist that allows PC control (PC shutdown, media files,
PowerPoint files)*

Built-in Database Generator for device driver setup and overall device
management.

Built-in ATEN Library comprising 10,000+ device drivers and complete
ATEN VanCryst product drivers

Event scheduling

Two-way communication enables user-defined event monitoring to
automatically trigger the next actions

Test tool to verify commands in action before uploading the Viewer to the
ATEN controller

Simulator to simulate and review the customized GUI before uploading

Note: For details on the supported PC control actions, see Supported PC

Control Actions, page 260.

ATEN Control System App

*

Allows administrators central control of multiple rooms via Viewers on a
mobile device or tablet computer

Restrict user access to Viewers via password authentication

Synchronization of system controls amongst multiple mobile devices and
tablet computers

Any 108, Android, or Windows mobile device can be used to control the
system — no need to purchase costly
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Control Interfaces

ATEN Keypads
Fully customizable layout

+ VKI108US: 14 layout variations using 4 to 8 buttons

¢ VKI112EU: 125 layout variations using 6 to 12 buttons

System LED indicators for quick connection status check
Dual-color LEDs for clear indication in dark environments

Easy ID pairing with ATEN controller for Ethernet communication
Scalability — an ATEN controller can connect up to 8 Keypads
Versatile modes support flexible behavior settings for each button
Intuitive Web GUI for easy configuration

Redundant power supplies (DC power and PoE)

Button engraving service

ATEN Touch Panel

*

*

10.1 touch panel

Natively installed with the ATEN Control System app for centralized
control of control system deployments

PoE-compatible
Capacitive multi-touch screen

Flexible mounting using any standard VESA-compliant 75 x 75 mm
equipment or desk / wall mounting using the ATEN VK304 tabletop kit /
VK302 wall mount kit




Chapter 1. Introduction

Requirements

Prepare the following equipment and make sure your equipment meets the
minimum requirements specified below.

+ Hardware devices to be controlled by your ATEN controller
+ Bidirectional RS-232/422/485 serial devices

¢ One-way IR or serial transmitter hardware devices (for Control Box
only)

+ Relay hardware devices

¢ Digital input hardware devices (for VK1200 / VK2100 / VK2200 and
Control Pad only)

+ Digital output hardware devices (for VK1200 / VK2100 / VK2200
only)

¢ Ethernet-controlled PJLink, Telnet, ONVIF, TCP, UDP, HTTP, or
HTTPS devices

+ KNX-interface IP devices
¢ Cables
+ One Cat 5e/6 Ethernet cable for connecting to the local area network

¢ (Optional) Standard straight-through cables for serial devices with
DB9 connectors

+ A computer for configuring your ATEN Control System
¢ Make sure the computer runs Windows 7, 8, 8.1 or 10

+ Make sure to install NET Framework version 4.5 or later on the
computer before using the ATEN Database Generator

¢ (Optional) Up to 10, 16 or 32 mobile devices for remote control,
respectively for Control Pad, VK1100 / VK2100, or VK1200 / VK2200

Note: A license is required for each mobile device. For detailed
information, see Licenses for Mobile Control, page 78.
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Accessories

Optionally purchase ATEN accessories to enhance the functionality of your
Control System. For more information, visit the ATEN website. Contact your
ATEN dealer to purchase these accessories.

Model Description
2XRT-0004G Full Range IR Emitter (1.8 m)
2X-031G Single Rack Mount Kit for VK1100
2X-049G Single Rack Mount Kit for VK1200
2X-021G Dual Rack Mount Kit for VK1200
SA0141 DB9-F to RJ45-F Adapter
SA0145 RJ45-F to DB9-M Adapter

10
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Chapter 2

Hardware Setup and Panel
Operation

device is provided on Safety Instructions, page 283. Please

g 1. Important safety information regarding the placement of this
review it before proceeding.

2. Make sure that the power to all devices connected to the
installation are turned off. You must unplug the power cords of
any computers that have the Keyboard Power On function.

ATEN Control Box

Panel Components

VK2100 Front View

o
o
o
°
o
o
o
o
o
o
o
°
oo
oo
oo
oo
oo
oo
o
o
o
°
o
o

—
—_
o
—
L

9 10
VK1100 Front View
ATEN
oooo 00 2 2 oo oDoo@oo

oy

oL

6 7 1 9 10




ATEN Control System User Manual

No.

Component

Description

relay LEDs

The LEDs light green to indicate an active device connection
(closed loop).

IR / serial LEDs

The LEDs light green to indicate an active device connection
or IR / serial signals being transmitted.

I/0 LEDs

The LEDs light green to indicate an active device connection
or I/O signals being transmitted.

serial LEDs

The LEDs (1~6) light green to indicate serial signals being
transmitted.

Ethernet link /
ACT LED

The LEDs provide information about the network

connection:

¢ Link: The LED blinks green to indicate Ethernet signals
being transmitted.

¢ ACT: The LED lights green to indicate 100-Mbps trans-
missions.

DC overload LED

The LED lights orange to indicate DC output exceeding the
maximum output threshold.

Note: When the LED lights orange, please unplug any of the
connected devices to keep its total output under 12 /24 W.

IR receiver / LED

Passes the functions of a remote control to the Control Box
in learning mode. The distance between the IR remote and
the receiver window should be kept under 10 cm with a
direct line of sight.

¢ The LED blinks green to indicate the unit is ready to
receive signals from an IR remote control.

USB port / LED

This is where a USB device plugs in to upload Viewers to
the Control Box.

¢ The LED blinks green to indicate that Viewers are being
uploaded, and lights green to indicate that the upload was
successful.

¢ The LED lights orange to indicate Viewer upload failure.

reset button

¢ To clear all configurations except for its network and
license settings, press and hold the reset button for 8
seconds.

¢ To reset the network settings, short press the reset
button once.

Note: For more reset button functions, see page 321.

10

power LED

Lights green when the unit is turned on.

12
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No. Component Description
11 | controller ID Used to set an ID for the Control Box.
switch

13
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VK2100 Rear View

2 3 5 4 6 9 10
No. Component Description

1 grounding terminal Connects to the grounding wire.

2 power socket Plugs in the power cord from an AC power source.

3 power switch Powers the unit on or off.

4 DC output ports 4 / 1 output port(s) providing a total power output of 24
/12 W max.

5 relay channels Four channels; normally open, isolated relays with a
contact rating of 24 V DC, 2 A max.

6 IR / serial ports 4/ 2 IR ports that can also be configured as RS-232
TX ports. pin1: Signal / pin2: Ground.

7 I/O channels 4 channels that can be configured as digital input or
digital output ports.
+ Digital Input: 0 - 24 V DC programmable input range

or contact closure with +12 VV DC pull-up

# Digital Output: 250 mA sink from 12V DC
pin1~4: Signal / pin5: Ground

8 RS-232 serial ports Two RS-232 ports with TX/RX functions.

14
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No. Component Description
9 RS-232/422/485 4 |/ 2 ports supporting RS-232/422/485 conversion by
serial ports pin assignment and RTS/CTS flow control. The RS-

232, RS-422, or RS-485 connection is defined by pin.
For pin assignments, see page 39.

10 | Ethernet port Connects the unit to a network. If no IP address is
assigned by a DHCP server within 30 seconds, the
below default IP settings are used:

IP: 192.168.0.60 / mask: 255.255.255.0

1 controller ID switch Used to set an ID for the Control Box.

VK2200 Front View
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VK1200 Front View
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No.

Component

Description

N

relay LEDs

I/O LEDs

IR / serial LEDs

serial LEDs

¢ Lights green to indicate an active device connection or
signals being transmitted.

< Blinks green once to indicate system startup, with the
buzzer beeping once

LAN LED

ol |l OIDN

Control LAN LED

Lights green to indicate successful connection to the
network.

DC output
overload LED

Lights orange to indicate DC output exceeding the
maximum output threshold, with the buzzer beeping for 3
seconds.

Note: Please unplug any of the connected devices to keep
its total output under 12 V DC, 1 A/ 2A for VK1200 /
VK2200 and restart the controller unit.

IR receiver / LED

Passes the functions of a remote control to the VK1100 in
learning mode. The distance between the IR remote and
the receiver window should be kept under 10 cm with a
direct line of sight.

¢ The LED blinks green to indicate the unit is receiving
signals from an IR remote control

¢ The LED lights green to indicate entering learning
mode, or IR learning success with the buzzer beeping
once.

USB port / LED

Plugs in a USB device to upload Viewers (configured by
the VK6000) to the VK1100.

¢ The LED blinks green to indicate that Viewers are being
uploaded, and lights green to indicate a successful
upload, with the buzzer beeping once upon USB plug-in
and once upon upload success.

¢ The LED lights orange to indicate upload failure, with
the buzzer beeping 3 times for no available file found or
upload failure.

10

reset button

¢ Clear all settings but network and license: Press
and hold until the front panel LEDs blink once, with the
buzzer beeping once (about 8 seconds). The LEDs
and buzzer will trigger once more when the reset is
complete.

+ Reset network settings: Short press once.

Note: For more reset button functions, see page 321.

16
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No. Component Description

11 |LCD panel and Use the Up, Down, and Enter buttons to display the unit's
buttons system information, and set its controller ID.

12 | power LED Lights green when the unit is turned on.

VK2200 Rear View

i i
e (| (SRR (RRREH (A

1”1 1 2 3 4 5 6

VK1200 Rear View

Q 1 I 1 ;‘ 1 ; - 1 “" 1 1

No. Component Description
1 power socket Plugs in the power cord from an AC power source.
2 power switch Powers the unit on or off.

3 12 V DC output ports | 1 /4 DC output port(s) providing a total output of 12 V
DC, 1 /2 Afrom the VK1200 / VK2200.

4 relay channels 4 / 8 channels; normally open, isolated relays with a
contact rating of 24 V DC, 2 A max.

17
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No.

Component

Description

1/0 channels

2/ 8 channels that can be configured as digital inputs
or outputs, with the first pin being ground and the rest
being number pins.

¢ Digital Input:

¢ VDC Mode: 0 - 24 V DC; programmable range
of 1-24V DC

¢ Dry Contact Mode: Pull-up 2k Q to +12 V DC
¢ Digital Output: 300 mA sink from 24 V DC

IR / serial ports

2/ 8 IR ports that can also be configured as RS-232
TX ports. pin 1: Signal / pin 2: Ground.

RS-232/422/485
serial ports

1/ 2 5-pin RS-232/422/485 serial ports by pin
assignment.

RS-232 serial ports

1/ 6 3-pin RS-232 serial ports with Tx, Rx and GND.

Control LAN

Connects the unit to a secure subnetwork, separate
from the corporate LAN, for managing IP devices and
configuration by the ATEN Configurator VK6000, as
well as for remote control by ATEN Keypads, Touch
Panel or the ATEN Control System app on mobile
devices.

10

LAN

Connects the unit to the corporate LAN for remote
access and centralized management by ATEN Unizon.

1

grounding terminal

Connects to the grounding wire.

18
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Rack Mounting the ATEN Control Box

VK2100 / VK2200

1. The VK2100 / VK2200 can be mounted onto a 19” (1U) system rack. The
following diagrams are exemplified using VK2100.Using the rack mount
kit, attach the 2 mounting brackets onto the sides of the unit with the 6
screws included.

2. Align the mounting brackets’ screw holes with that of the front of the rack,
and use 4 self-supplied screws to secure the unit onto the rack.

e

19
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VK1100
Optionally purchase an ATEN Rack Mount Kit (2X-031G) to install VK1100
onto a 19” (1U) system rack.

1. Remove the 2 screws from the bottom and 1 screw from each side of the
unit.

2. Using the 2 bottom screws from step 1 and 2 M3x6 screws from the rack
mount kit, secure the mounting brackets to the sides of the VK1100.

M3X6
Hexagon
Screw

3. Use 4 self-supplied screw to secure the mounting brackets onto the rack.

£000060006608080660060008
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VK1200

Optionally purchase an ATEN Rack Mount Kit to install VK1200 ontoa a 19”
(1U) system rack. Users can select the 2X-049G or 2X-021G rack mount kit
for single or dual rack mount, respectively.

B Single Rack Mount

1. Using the rack mount kit, attach the 2 mounting brackets onto the sides of
the unit with the 4 screws (M3x6) included.

2. Align the mounting brackets’ screw holes with that of the front of the rack,
and secure the unit onto the rack using 2 self-supplied screws.

>

LO00086008000000000058]
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B Double Rack Mount

1. Remove 2 screws at the bottom and 1 screw at the side from each of the
two VK1200 units, as shown below.

2. Use 4 of the screws from step 2 to secure the two VK 1200 units together
with the link bracket. Then install the left and right mounting brackets
onto the sides of the units using 2 of the M3x5 and M3x6 screws included.

3. Align the mounting brackets’ screw holes with that of the front of the rack,
and secure the units onto the rack using 4 self-supplied screw.

ooooo
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Control Box Connections

Installation of the Control Box is a matter of connecting the appropriate wires.
To set up each device, refer to the installation diagrams on the pages that
follows (each step provides a corresponding page with diagram for the
VK2100/ VK2200 and VK1100 / VK1200), and do the following:

1.

Use a grounding wire to ground the unit by connecting one end to the
grounding terminal and the other end to a suitable grounded object.

Note: Do not omit this step. Proper grounding helps prevent damage to the
unit from surges or static electricity.

Plug the power cord into the Control Box’s power socket, and connect it to
an AC power source.

Use a Cat 5¢/6 cable to connect the VK1100 / VK2100’s Ethernet port or
VK1200/ VK2200’s Control LAN port to a secured subnetwork.

(Optional) For VK1200 / VK2200, use another Cat 5¢/6 cable to connect
its LAN port to the corporate network.

Use the DC output terminals to wire 12 V DC power connections using the
instructions on page 31.

Use the relay terminals to wire relay device connections using the
instructions on page 33.

Use the IR / serial (RS-232 TX) terminals to wire IR or serial device
connections using the instructions on page 34.

For VK1200 / VK2100 / VK2200, use the digital I/O terminals to wire
digital input / output device connections using the instructions on page 36.

For VK1200 / VK2100 / VK2200, use the 3-pin RS-232 terminals to wire
RS-232 serial device connections using the instructions on page 38.

10. For VK1100 / VK2100, use the DB-9 ports to wire RS-232/422/485 serial

device connections using the instructions on page 39.

11. For VK1200 / VK2200, use the 5-pin RS-232/422/485 terminals to wire

the corresponding serial device connections using the instructions on .

12. Connect IP-based devices to the same network as the Control Box. Refer

to Ethernet / Control LAN, page 43 for details.

23
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Note:

1. For KNX-compliant devices, connect the devices to a KNX IP
interface, and then connect the KNX IP interface to the network
where the Control Box is installed.

2. To check if the KNX functions are supported by the Control Box,
see Specifications, page 286.

13. For VK1100/ VK2100, use the controller ID switch to assign an ID to this
unit.

14. Start the unit by switching on its power switch.

15.For VK1200 / VK2200, use the LCD panel to set its ID.

24
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VK2100 Installation Diagram
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VK2200 Installation Diagram
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VK1100 Installation Diagram
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VK1200 Installation Diagram
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12 V DC Power Qutput

ATEN Control Box offers the following 12 V DC outputs for providing power
to hardware devices:

VK1100 / VK1200 VK2100 / VK2200
Number of Channels 1 4
Max. Power Supply DC12V,1A DC12V,2A

The outputs can power one or four independent hardware devices, one or four
loops for connected relay devices, or one or four digital output devices.

If the combined current of the ports exceeds 1 A (VK1100/VK1200) or 2 A
(VK2100 / VK2200), the DC power overload LED lights orange, an alarm
beeps three times, and the ports are turned off. To return power to the ports,
power off the Control Box, unplug all hardware connected to the 12 V DC
output ports, power on the Control Box, and then plug in the hardware devices,
one at a time, and make sure the current does not exceed 1 A or 2 A.

The diagrams on the next three pages show ports on the VK2100 / VK2200.
The VK1100 /VK1200 is the same except that it has fewer 12 V DC terminal
blocks, and the VK 1100 has no I/O ports.

Independent Power Supply
12 V DC Output Ports

Power Supply: 12V DC,
1A/2AMax

[ ouTPUT:12V = 24w TOTAL

Connects to

Provides 12 V DC power to
independent hardware devices.

—
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Relay Power Supply

12 V DC Output Ports

[ Power Supply: 12V DC,
1A/2AMax

OUTPUT:12V == 24W TOTAL
INPUT:24V = MAXIMUM

Connects to

Switch, Screen, Projector Lift,
‘—> Lighting, Motorized Equipment,
Motion Device, etc.

Provides 12 V DC power
for the relay loop.

30
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Digital Output Power Supply (inapplicable to VK1100)

12 V DC Output Ports

[ Power Supply: 12V DC,

1A/2AMax

110
1 2 3 4 GND

OUTPUT:12V == 24W TOTAL

+ - + -

Bl W

@@@@ S6666

Provides 12 V DC power
for the digital output loop.

GND

2/

v

Connects to

‘ Switch, Screen, Projector Lift,

Lighting and Equipment Control.
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Digital Output Dual Power Supply (VK2100 / VK2200 only)

12V DC Output Ports

Power Supply: 12V DC,
1A/2AMax

OUTPUT:12V === 24W TOTAL

/0

2 3 4 GND

Provides 12 V DC power
for the digital output loop.

>

AT

SISISISIS)

1 2

digital output #2.

‘ Provides connection to

Provides connection to
digital output #1.

GND
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Relay
ATEN Control Box provides the following isolated relays:
VK1100 / VK1200 /
VK2100 VK2200
Number of Channels 4 8
Contact Rating 24V DC, 2A
Default Status Normally Open
Relay Channels

| NO, Isolated Relays:
| 24 V DC 2 A Max

Normally
Open Closed

=
=2
=
3
<
=
Ii
>
<
o
=
=
o.
z

Connects to

Switch, Screen, Projector Lift,
—>» | Lighting, Motorized Equipment,
Motion Device, etc.
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IR / Serial
ATEN Control Box provides the following IR / serial (RS-232) ports:
Ko/ VK2100 VK2200
2-Pin IR/Serial 2 4 8
Carrier Frequency 10 ~ 455 kHz
R Default Level Low
Baud rate 300 ~ 115200 (default: 9600)
Data bit 7, 8 (default)
(ngi;gz Stop bit 1 (default), 2
Parity None (default), Even, Odd
Signal Level TTL(0~5VDC) | TIL(+-5V) | TTL(0~5V DC)

IR

| TTL Level (0 ~ 5 V)
Carrier Frequency:
10 ~ 455 kHz

IR/SERIAL or

S G S G
I—

RS-232 Ports

Unidirectional (0 ~5V
or +/-5V)

Baud Rate: 300 to 115200
(default: 9600)

Data Bit: 8 (default) or 7

Stop Bit: 1 (default) or 2

Parity: None (default), Even or
Odd

Connects to

IR: Blu-ray / DVD Player, TV,
Audio Receiver, Projector, etc.

RS-232: Camera, Projector,
Switch, Audio Mixer, Multimedia
Device, etc.

By default, the unidirectional IR / serial channels are set to transmit IR signals.

IR Connection: Connect a transmitter cable to a set of IR and ground terminals
of the the Control Box, and install the IR transmitter on or near the IR device's
IR receiving port, as shown on page 35.
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Serial Connection: Connect a serial device's receiver (RX) and ground
terminals to a set of serial (TX) and ground terminals of the Control Box. Then
configure the same serial port settings on both the Control Box and the
connecting serial device, allowing them to communicate.

One IR Transmitter

IR/SERIAL
scsa

&wm

Two IR Transmitters

IR/SERIAL
s 6s o

1

2 x IR Transmitters

1

' ' Unidirectional IR
L

35
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Digital 1/0
The VK1200/ VK2100/ VK2200 provides the following digital input / output
channels:
VK1200 VK2200 VK2100
Number of Channels 2 8 4
Voltage range: 0 ~ 24 V DC
Digital VDC Mode Programmable range: 1 ~24 V DC
Input
Dry Contact Mode Pull-up: 2 kQ to +12 V DC
Normally Open
- Normally Open g
Digital Output h 250 mA sink
300 mA sink from 24 V DC from 12 V DC

Programmable Digital
Input Channels

[[[e}

Digital Input
VDC Mode:

Dry Contact Mode:
-Pull-up 2kQ to + 12V DC

-Input Voltage Range: 0 ~ 24 V DC
-Programmable Range: 1 ~ 24 VDC

EEEEE
[T

Connects to

==

Digital Input: Switches, Sensors
Monitors and Button Triggers.

[
b

Digital Input (Dry Contact):

Connects to digital I/O devices with an input loop — open or closed — for
providing indicators from sensors or switches of an event, which can be used
by the Control Box to trigger events and/or functions.

Digital Input (VDC Mode):

Connects to DC devices (temperature, current and monitor sensors) for
providing voltage signals (1 ! 24 V) to the ATEN Control Box, to trigger
certain events and/or functions when the voltage signals are above or below

the defined threshold.
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Programmable Digital
Output Channels

Digital Output:
250 mA sink from 12 V DC

/o
1.2 3 4 GND

[k

@E@@ Connects to

Digital Output: Switch, Screen,
Projector Lift, Lighting and

SISISISIS/
Equipment Control.

L=

i —
R—

| —
E—(— Relay
— Module

—

Digital Output:

Provides non-powered dry contact (open and closed) circuit control of
hardware devices, such as electric screens, projector lifts and other motorized
equipment, which must be connected using a relay module, as shown below.
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RS-232 (3-Pin)
VK1200 / VK2100 / VK2200 provides the following 3-pin RS-232 ports:

VK1200 VK2100 VK2200
Number of Channels 1 2 6
Baud rate 300 ~ 115200 (default: 9600)
Data bit 7, 8 (default)
Stop bit 1 (default), 2
Parity None (default), Even, Odd

Bidirectional RS-232 Ports

Baud Rate: 300 to 115200
(default: 9600)

Data Bit: 8 (default) or 7

SERIAL
RS-232 Stop Bit: 1 (default) or 2

1 2
TX RX GND TXRX GND Parity: None (ddedfault), even or
o]

Connects to

Projector, Matrix Switch,
> ’ Camera, etc.

Connect to devices for controlling and receiving status messages from them.
For bidirectional RS-232 control, the transmit (TX), receive (RX) and ground
(GND) terminals must be wired on both the ATEN Control System and the
device connecting
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RS-232 /422 / 485 (DB-9)

These two or four (VK1100 / VK2100) bidirectional ports provide serial
control of hardware devices (projectors, switches, etc.) with programmable pin
assignments and receive status messages from the connected devices. The
diagram below shows ports on the VK2100. The VK1100 is the same except
that it has fewer ports.

Programmable
Bidirectional RS-232/422/485 Ports

Configurable by pin assignment

Baud Rate: 300 to 115200
(default: 9600)

SERIAL
RS-232/422/485

Data Bit: 8 (default) or 7

Stop Bit: 1 (default) or 2

Parity: None (default), Even or
Odd
Flow Control: None (default) or
RTS/CTS

Connects to

Projector, Matrix Switch,

Camera, etc.
Pin Assignments

RS-232 RS-422 RS-485
pin 2: RX pin 1: RX- pin 3: D+
pin 3: TX pin 2: RX+ pin 4: D-
pin 5: GND pin 3: TX+
pin 7: RTS pin 4: TX-
pin 8: CTS pin 5: GND

RS-232/422 ] 485 (5-Pin)
The ATEN Control System provides the following RS-232/422/485 ports:

VK1200 VK2200
Number of Channels 1 2
Baud rate 300 ~ 115200 (default: 9600)
Data bit 7, 8 (default)
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VK1200 | VK2200

Stop bit 1 (default), 2

Parity None (default), Even, Odd
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Bidirectional
[ RS-232/422 /485 Ports

SERIAL ) ; ;
RS-232/422/485 I Configurable by pin assignment

Tx Rx GND RTS CTS

RREIEE

Tx+ Tx- GND Rx+ Rx-

EERETE

T e

-
=
7]
=
=
<
]
<
=
o

6666 EEEEE .

| —>

| Connects
o OnneeE
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Connect to devices, configurable by pin assignments, for controlling and
receiving status messages from them.
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Ethernet / Control LAN

The Ethernet / Control LAN port provides an Ethernet connection for
controlling up to 25 (VK1100 / VK2100) or 64 (VK1200 / VK2200) LAN
devices and/or remote control by ATEN Keypads, Touch Panel, and the ATEN
Control System app on a mobile device in a network .

The RJ-45 port is used to connect
and access TCP, UDP, PJLink,
ONVIF, HTTP, HTTPS, and Telnet
devices.

Ethernet /
Control LAN VK1200 / 2200 can operate as a
DHCP server for assigning IP

addresses to the devices

~
ONVIF
@
e
===
PJLink
Ethernet Switch — > [——— \
\a
ddm !
O e
— -
Modular Matrix Switch
VK224 Telnet
KNXIP | it
nterface VK236
VK248 eco PDU
VK258

Expansion Box
UDP
Lighting HVAC Systems

HTTP \,
HTTPS

Video Conferencing System
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ATEN Control Pad

Panel Components

VK0100

Front View Rear View

VK0200

Front View

Side View
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No.

Component

Description

buttons and button
LEDs

Indicate the status of the Control Pad and if the function
on each button, e.g. lighting or projector, is on or off. For
detailed information about device/function status under

different LED activities, see LED Indications, page 46.

system LEDs

Contains a LAN and a link LED to indicate network
connection and data transmission status:

¢ LAN LED lights green to indicate that the Control
Pad is connected to network.

¢ Link LED lights green to indicate that the Control
Pad is actively transmitting and receiving data.

reset button

¢ To clear all the configurations except the network
settings, press and hold the reset button for 8
seconds.

* To reset the network settings, press the reset button
once.

RS-232 serial ports

Connect up to two RS-232 serial devices.

relay channels

Connect up to two relay devices. Relay contacts are
normally open, isolated with a contact rating of 24 V DC,
1 A max.

digital input Port

Connect to one digital input device that supports
programmable input (1 ~ 5V DC) or dry contact (pull-up
2k ohms to 5 V DC).

Ethernet port

Connects to an Ethernet cable to provide power and
access to the network.

control pad ID switch

Sets an ID for the Control Pad.

DC power port

Connects to a 5 V DC power adapter.
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LED Indications

Refer to the table below for the status descriptions of a Control Pad indicated
by button LEDs.

Button LED Status LED Activity Control Pad Status
a button LED lights orange The Control Pad is powered on and the
button is currently off.
a button LED lights white The Control Pad is powered on and the
button is currently on.
a button LED blinks orange and The function assigned to the button is
white repeatedly being executed.
all button LEDs blink orange and The Control Pad is restoring its default
white once settings.
all button LEDs blink orange and The firmware of the Control Pad is being
white repeatedly upgraded.
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Installing the Control Pads

Installation Steps
Follow the steps below to safely install the Control Pad.

VKO0100
RS-232
Projector Video Switch
) 3 —aE
DI
Relay
@D Dry Contact
Lighting @ Device
Control LU e
= '| Door
I Sensor
Screen
PoE Switch

-_13 Projector

@ Conference
System

Q Camera

Ethernet
Cable

Projector
Lift O

VKO0200

DI
Dry Contact Door
Device Sensor

RS-232
Projector Video Switch

Relay
Lighting@
Control L.
Screen]:ll

Projector
Lift 0

Q

@ Projector

@ Conference
System

Q Camera

Ethernet
Cable

47



ATEN Control System User Manual

1.

Prepare the installation site.
a) Choose a location where cables are free of interference.

b) Prepare a recession in the wall to accommodate the Control Pad.
Download a CAD diagram from the product web page.

Connect the Control Pad to serial, relay, and/or digital input devices using
the supplied terminal blocks.

For details, see RS-232 Serial Connection, page 52, Relay Connections,
page 53, Digital Input Device, page 54 respectively.

Note: To expand connection ports on the Control Pad, install ATEN
Expansion Boxes.

To use PoE, connect the Control Pad to a PoE switch via an Ethernet cable.
For details, see Ethernet, page 55.
If you do not have power sourcing equipment for PoE, contact your local

sales representative to purchase a power adapter and then follow the steps
below to prepare the power cord.

o~

+5V ||l GND
/

5mm

+5V S s
GND |

a) Cut the connector end of the power adapter.

b) Strip 5 mm (0.5 cm) off the insulation cover of the power adapter cable
to expose the +5V wire and the grounding wire.

c) Insert the expose +5V wire and the grounding wire tightly into the
provided 2-pin terminal block connector.

Note: Use a voltmeter to determine the polarity of an exposed wire.

d) Plug the power terminal block to the DC power port on the Control Pad.
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5. Use the ID Switch to assign an ID to the Control Pad.

Note: It is possible to install more than 16 controllers under the same
subnet. In which case, the 17th controller and the ones added after
that will each be sharing its ID with another controller. If you have
any ATEN Expansion Box and/or Keypad connected to controllers
using shared IDs, reconfigure the connection mode. For details, see
Controller Properties, page 109.

6. Power on all the devices. The button LEDs light orange.
7. Assemble the button caps onto the Control Pad.

a) Assemble button caps of the same row with each other.

O-TT

b) From the top row, attach each row of button caps to the Control Pad by
pressing on the hinges.

Caution: When removing button caps, place your fingers on the top of
button caps and then press downwards, as illustrated below. Pressing
upwards from the bottom may cause damages to the button caps.

(=)
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8. Mount the Control Pad to the wall.
a) Secure the Control Pad to the wall with self-prepared screws.

b) Install the supplied faceplate to the Control Pad.
VKO0100

VK0200 (EU)
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VK0200 (MK)
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RS-232 Serial Connection

The two bidirectional RS-232 ports on the Control Pad provide serial control
of hardware devices (projectors, matrix switches, etc.) and receive status
messages from the connected devices. For bidirectional RS-232 control, the
transmit, receive, and ground pins must be wired on both the Control Pad and
hardware device. Each hardware device requires different wiring. Please
consult each hardware device's manual for details.

Bidirectional RS-232 Ports

Baud Rate: 300 to 115200
(default: 9600)

Data Bit: 8 (default) or 7

SERIAL
RS-232 Stop Bit: 1 (default) or 2
1 2
TX RX GND TX RX GND Parity: None (default), even or

odd

7] W

Connects to

3 Projector, Matrix Switch,
Camera, etc.
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Relay Connections

These 2 relay channels provide connections to control hardware devices such
as electric screens, projector lifts and other motorized equipment. Each relay is
normally open by default.

2 x Relay Channels

[ Normally Open, Isolated Relays
| Contact Rating: 24VDC 1A Max

RELAY

Normally
Open Closed

=
2
2
x
<
=
Ii
>
<
o
-
2
o
z

HliEEE

=
2
I S

Connects to

Switch, Screen, Projector Lift,
—>» | Lighting, Motorized Equipment,
Motion Device, etc.
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Digital Input Device

The digital input port on the Control Pad can be used to install a digital input
device such as a switch or a sensor. The digital input channel can be configured
to the VDC mode or the Dry Contact mode.

1 x Programmable Digital
Input Channel

| Digital Input

VDC Mode:
-Input Voltage Range: 0 to 5 VDC
-Programmable Range: 1 to 5 VDC

Dry Contact Mode:
-Pull-up 2k ohms to + 5 VDC

Connects to

Digital Input: Switches,
> Sensors, Monitors, or Button

Digital Input (Dry Contact):

Digital inputs are hardware devices (switches, sensors, monitors) with two
circuit signals — open and closed. These two signals provide indicators from
sensors or switches of an event. An event can be the on/off power, dry contact,
sensor or switch status from a device. This information is used to trigger events
and functions through the Control Pad.

Digital Input (VDC):

Digital input 5VDC hardware devices (temperature, current and monitor
sensors) provide voltage signals between 1 and 5. A digital input port detects
if a voltage is above/below a specific threshold (1 to 5). If the voltage coming
from a hardware device is higher than the set value, the Control Pad will
detect the digital input as high. If the voltage coming from a hardware device
is lower than the set value, the Control Pad will detect the digital input as low.

This information is used to trigger events and functions through the Control
Pad.
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Ethernet
The RJ-45 port provides an Ethernet connection for GUI access (page 73) and
the ability to add up to 8 LAN devices per Control Pad, as shown below.

The RJ-45 port is used to connect
and access TCP, UDP, PJLink,
Ethernet ONVIF, HTTP, HTTPS, and Telnet

devices.

ONVIF 6
-
e\
gy
. .
PJLink
Ethernet Switch —» [———

]t

¢ — -

Modular Matrix Switch

VK224 Telnet
KNXIP | f
nterface VK236
VK248 eco PDU
VK258

Expansion Box
UDP
Lighting HVAC Systems

HTTP \,
HTTPS

Video Conferencing System
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ATEN Expansion Box

ATEN Expansion Boxes (sold separately) provide additional ports for a
flexible expansion of the ATEN Control System. This allows you to add and
control additional devices in an environment when more devices are required.
With the advantage of an Ethernet-based connection, the expansion boxes are
easily connected to the ATEN controller via a LAN connection from a variety
of locations across a network. The diagram below provides a setup example
using the VK224, a 4-Port Serial Expansion Box.

VK224 (Rear)

456
@ o= of=)
O}

1 2

T
e —— RS-232/422/485 ——

e
- -
.m° °m°
+ 3 4

Control Box Power Distribution Video Matrix Projector Camera
Unit
Serial Devices

Ethernet

Serial

Note:

+ To add and configure ATEN Expansion Boxes, see Left Sidebar, page 103
and Expansion Box (Expander), page 111.

¢ Theavailable Expansion Box models include:

Model Description
VK224 4-Port Serial Expansion
VK236 6-Port IR/Serial Expansion Box
VK248 8-Channel Relay Expansion Box
VK258 8-Channel Digital 1/0 Expansion Box
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Control Interface Devices

ATEN Keypad

The ATEN Keypad mounts to a wall to provide control of hardware through a
Control Box. The setup of the Keypad to the Control System can be illustrated
as follows:

i

ATEN Keypad

—

ATEN

Screen BD-Player

Powered by PoE
orDC 5V

Ethernet Switch

VK1100
(Rear)

Note:
¢ The following Keypad models are available:
Model Description
VK108US 8-Button Keypad (US, 1 Gang)
VK112EU 12-Button Keypad (EU, 2 Gang)

* You can have your Keypad buttons customized with text engraving. To
make the order, go the this link:
https://www.aten.com/ext _data/global en/VK Keypad Engraving_Service/
aten_keypad.html
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Component

The VK108US and VK112EU Keypads share the same hardware layout. For
demonstration purpose, VK112EU is used as an example below.

wuw g6

No. Component Description
1 |buttons VK108US
The Keypad can be customized up to 14 different layouts
using 4 to 8 buttons.
VK112EU
The Keypad can be customized up to 12 different layouts
using 6 to 12 buttons.
2 | button LEDs * Indicate function and Keypad statuses. For detailed
information, see LED Indications, page 59.
3 |system LED ¢ LAN: lights green to indicate that the Keypad is connected
indicators to LAN.
¢ Link: lights green to indicate that the Keypad is connected
to the assigned Control Box.
4 | reset pushbutton | Press to reset the Keypad to its default network settings.
DC power Plug a power adapter into this DC power input.
6 |keypad ID switch | Sets an ID to the Keypad (1~8).
(blue)
7 | control box ID Sets the ID of the Control Box (1 ~ 16) to which the Keypad

switch (black)

connects.
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No. Component

Description

8 | LAN port

installed.

¢ Connects the Keypad to LAN

¢ Supplies power (PoE) if a power sourcing equipment is

LED Indications

Refer to the table below for the status descriptions of a Keypad indicated by

button LEDs.

Keypad Button

LED Activity

Control Pad Status

a button LED

lights orange

The Keypad is powered on and the button
is currently off.

lights white

The Keypad is powered on and the button
is currently on.

blinks orange and
white repeatedly

The function assigned to the button is
being executed.

all button LEDs

blink orange and
white repeatedly

The firmware of the Control Pad is being
upgraded.

blink orange

The Keypad is disconnected from the
controller.
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Layout Examples
VK108US

WATEN ATEN ATEN ATEN WATEN

WTEN WTEN WATEN WTEN WATEN

VKI112EU

M X :\":I"
[T i W CFTE
o =
: ::.m: :
e s TTT
T —— s =
"I “Irr T
- e
FTT = S
— T -
— = TTT
e e e
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Installing ATEN Keypad

You can install the Keypad in a wall, podium, or desk. To install the Keypad,
follow the steps below:

1. Choose a location free of interference and prepare the installation site. You
can install the Keypad to a wall box or directly into the chosen surface.
+ Using a wall box
Use a wall box of appropriate size (2-gang for the VK112EU; 1-gang
for the VK 108US) and depth (at least 6 cm, 2.36 inches).

VK108US

VK112EU
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VK112MK

¢ Directly into the chosen surface

a) Refer to the Panel Mount Cutout diagram (CAD and Panel Cutout
Diagrams, page 302) to find out the length and width of the cutout area
and mark the opening on the chosen surface.

b) Cut out the marked area to a depth of at least 6 cm (2.36 inches).

Pair the Keypad with a Control Box by adjusting the Keypad ID Switch
(blue) to the ID number that the Control Box uses.

Note: One ATEN Control Box can work with up to 8 Keypads.

. Supply the Keypad with power and network connectivity using one of the

following methods. The LAN LED light green to indicate that the Keypad
is supplied with power and successfully linked to the network.

+ To power the Keypad by PoE, use an Ethernet cable to connect the
Keypad to a PoE-enabled Ethernet switch.

¢ If you do not have a power sourcing equipment, use an Ethernet cable
to connect the Keypad to LAN and a power adapter to supply power.

+ Purchase a power adapter for this installation.

+ Follow the steps below to prepare the power adapter and then plug
it to the Keypad.
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a) Cut the connector end of the power adapter cable.

b) Strip 0.5 cm off the insulation cover of the power adapter cable to
expose the two wires, the +5V wire, and the grounding wire. To
determine wire polarity, use a voltmeter.

¢) Insert the exposed wires into the supplied 2-pin terminal block.

Note:

* Make sure to install the Keypad in the same subnet with its assigned
Control Box.

+ The Keypad adopts the default IP address 192.168.0.60 if the network
switch does not support DHCP. To configure the IP address, log in the
web interface using the default IP address and the default password
(password).

. Secure the Keypad to the installation site and install the button caps and
faceplate.

a) Secure the Keypad to the wall box or directly to the chosen site using
two screws.

b) Follow the layout created in the Viewer and assemble the button caps
onto the Keypad.

+ Assemble button caps of the same row with each other.

-
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+ From the top row, attach each row of button caps to the Keypad
by pressing on the hinges.

Caution: When removing button caps, place your fingers on the top
of button caps and then press downwards, as illustrated below.
Pressing upwards from the bottom may cause damages to the button
caps.

SIS E

Sl

c¢) Attach the faceplate to the Keypad.

IMPORTANT: After installing the Keypad, create a control interface
(Viewer) and upload the Viewer to the Control Box. For details, see Design,
page 100.
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Panel Overview

Front View

Top View

Rear View @

®

Bottom View

Chapter 2. Hardware Setup and Panel Oper-

000 ® 00
No. Component Description
1 touch screen Tap on the screen to operate the control system and/or
configure the touch panel.
2 status LED Lights on when the touch panel is powered on.
function button Press the Function button to show the settings page.
4 brightness up / down | Press to adjust the display brightness.
volume up / down Press to adjust the volume of the touch panel.
6 LAN port with PoE Receives an Ethernet cable which supplies network

connectivity (and power by PoE).
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No. Component Description
7 USB type-A port Use this port to update the ATEN Control System app
installed in the Touch Panel. For details, see Updating
Control System App, page 69.
8 Micro-USB port Use this port to upgrade/downgrade the device
firmware.
9 power jack Receives a power cord.
10 | power switch Turns the touch panel on or off.
1 speakers Plays beep sounds to indicate control actions.
12 | M4 screw holes for Used for mounting with M4 screws.
mounting
13 | reserved for These ports are reserved for debugging.

debugging purpose

Mounting the Touch Panel

The VK330 Touch Panel supports desk mount, wall mount, or any 3rd-party
mounting accessory that is VESA compliant (75 x 75 mm). For more information
about the mounting accessories, please visit the product web page.

Desk Mount

To mount the VK330 on a desk using ATEN desk mount accessory — VK304
— refer to the diagram below.
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Wall Mount

To mount the VK330 onto a wall using ATEN wall mount accessory — VK302
— follow the steps and refer to the diagrams below.

1. Secure the wall plate to the wall using the wall anchors and screws.
2. Secure the panel plate to the VK330 using the M4 screws.
3. Slide the panel plate to the wall plate to secure the VK330 onto the wall.

wall plate
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Installing the Touch Panel

1.

Use an Ethernet cable to connect the unit to a PoE switch or PoE injector to
provide power and access to the network.

Put the power switch to ON. The Touch Panel starts loading and displays
the Start page.

Operating the Touch Panel

*

For details on using the Control System app, see The ATEN Control
System App, page 264.

To configure system settings of the Touch Panel, press the Function
button on the device open the system settings page.

Changing the Interface Language

1.

2
3.
4

Press the Function button.

. Tap System > Languages & input > Languages > +Add a language.

Tap a preferred language. The selected option is added to the language list.

. Tap and hold the language you just added to the top of the list. The Touch

Panel uses the language that lists first.
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Configuring the Network Settings
1. Press the Function button.

2. Tap Network & Internet > Ethernet > Ethernet IP Mode to configure
the settings.

Updating Control System App
To update the Control System app on your ATEN Touch Panel, follow the
steps below.

1. Download the Control System app from the product web page and save the
file to a USB drive.

Insert the USB drive to the USB Type-A port.
Press the Function button to go to the system settings page.

Tap Storage. Under Portable Storage, tap the USB device you inserted.

A

Locate and tap the app file (.apk) to start the update.

Upgrading Firmware for ATEN Touch Panel

To upgrade the ATEN Touch Panel firmware on your ATEN Touch Panel,
follow the steps below.

1. Download the ATEN Touch Panel firmware package from the product web
page.
2. Unzip the downloaded firmware package.

3. In the update folder, locate the update.zip file and save it to the root
directory of a USB drive, e.g. E:\

v Compressed Folder Tools ~ VK330_V1.1_1.11.119.20210202_USB driver — [m] x

Home Share View Extract (7]

€« v <« VK330_V1.1_1.11.11g.20210202_USB driver » VK330_V1.1_1.11.119.20210202_USB driver v O Search VK330_V1.1_1.11.11g.2.. 0

A Name Date modified Type Size
~ g Quick access I

[ Desktop

Insert the USB drive to the USB Type-A port of the Touch Panel.

i update 2/24/2021 10:55 AM__ Compressed (zipp... agzzwixsl

Press the Function button to go to the system settings page.
Tap System > System updates.

Follow the on-screen instructions to upgrade the firmware.

® N o w ok

The VK330 reboots itself when the firmware upgrade is complete.
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Chapter 3

Web-Based Configuration and
Control

Overview

The ATEN controller can be configured over a standard TCP/IP connection via
its built-in Graphical User Interface (GUI). Because it can be accessed from
anywhere over a network or the Internet, operators can easily log in via a web
browser. The web interface can be used to upload licenses, set the access key,
enable monitors and upgrade the firmware.

Determining the IP Address

¢+ DHCP: When connected to a DHCP network, the ATEN controller is
automatically assigned with an IP address upon startup. To determine the
IP address of VK1200 / VK2200, see LCD Panel. To determine the IP
address of other ATEN controllers, see IP Installer.

¢ Non-DHCP: When no dynamic IP address is assigned to the ATEN
controllers within 30 seconds after startup, their default network settings

are applied, as described below:

Models Default IP Address
VK1200/ | Control LAN 192.168.0.60
VK2200 LAN 192.168.1.60
Other ATEN Controller 192.168.0.60
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LCD Panel

For VK1200 / VK2200, users can find its network information on the LCD
panel, via Information, as illustrated below.

Control Box ID [a11 »

<« BACK TO MENU

IP Installer

Using a Windows PC, download the IP Installer zip file in Support and
Downloads from the ATEN controller’s product web page. Then extract and
execute IPInstaller.exe. A window similar to the one below appears.

1P Network Device IP Installer - *
Device list:
Device Name | Model Mame | MAC Address | IP Address ‘ Exit |
PES2084 PEB2082 00-00-00-00-00-00 10.0.00.60
I 010, 100 About
f 010 100
RCM10A RCM1MA 00-00-00-00-00-00° - 10.0.00.60
SN300 SMa002P 00-00-00-00-00-00 - 10.0.00.60
wk2200 VE2200 00-00-00-00-00-00 - 10.0.00.60
WMOB0BHA WM0B0BHA  00-00-00-00-00-00  10.0.00.60
w2100 VE2100 00-00-00-00-00-00 10.0.00.60
w2100 VEZ2100 00-00-00-00-00-00 - 10.0.00.60
PN7320 PN7320 00-00-00-00-00-00 - 10.0.00.60
Enumerate
Pratacal [IPvd + Network adapter: | MAC: 00-00-00-00-00-00 |P; 10.0.00.60 j SetlP
|Pvd settings
¢ (btain an IP address automatically 0]

7 Use the following IP addiess:
o .3 .4 18

266 265 . 285 . 0

m 3 41 254

@ (Obtain DNS server address automatically
7 Use the following DMS server addresses: 9}

0.0 .1 .7 [

W, 0.1 .6 |

Make sure the proper network adapter is selected and click Enumerate to
search for and display your ATEN controllers within the Device List.
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Logging In

To access the GUI, type the IP address of the controller into the address bar of
any browser. If a Security Alert dialog box appears, accept the certificate — it
can be trusted. The Welcome screen appears:

E\T EN X]IEEZ:O(‘:'unholler

WELCOME

¢ The default access key is: password
¢ Only one user can log in at a time

* Supports Internet Explorer 9 or later
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Dashboard

The Dashboard appears when you successfully log in to the Control Box. The
Dashboard gives a quick view of each setting and provides a link to each page.
Click Edit to configure the settings.

VK2100
ATEN Controller

'VK2100 Information

General Grede Storage Existing Viewer

Avabie

1P Address 10.3.41.100 ——

MAC Address 00:10:74:b2:01:13 All Rooms

Date & Time 2018/07/07 11:01:13 ‘- .‘ Viewer1

FW Version V2.3.227.001

Licenses Bex
In Use
Not In Use
Total
Space Used
Space Available

Total Space

Access Key Menitor

Viewer Access Key Setting

The top bar provides two options:

Click to enter the Settings page.

E- Click to log out of the web console.
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Settings

The Settings view contains tabs consisting of different configurations of the
controller. The page is divided into two parts:

¢ Interactive Display Panel: configures the options

+ Top Bar: provides icons to exit the settings page and log out of the web
session.

General

Controller Info
Controller ID 1
IP Address 10.3.41.114

MAC Address 00:10:74:b2:01:99

Date & Time
© Automatically ® Manually
Time Zone (GMT-12.00) Eniwetok Kwajalein v
Preffered NTP Server
® Preferred Customer Server IP |G
Alternate NTP Server

m Alternate Customer Server IP |G
Adjust Time Every Days

\EEIEKA / KECA / KR KRG - S - S

Firmware

Current Firmware v2e6.253002 [

The General tab contains network information and the time and firmware
upgrade settings.

Setting Descriptions

Controller Info | Provides network and identification information pertaining to the
controller.

# Device Name: Sets the device name.

¢ Controller ID: Displays the controller ID # set on the rear of the
unit.

¢ IP Address: Provides the IP address of the controller.

¢ MAC Address: Provides the hardware MAC address of the
controller.

Note: For VK1200 / VK2200, two sets of IP and MAC addresses are
displayed, one for the Control LAN and one for the LAN.
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Setting

Descriptions

Date & Time

¢ Automatically

¢ Time Zone: Select a time zone for the controller. Choose the
city that most closely corresponds to where it is located.
NTP Server Settings

Assign an NTP server for the controller to synchronizes its clock.
If the controller has access to the Internet, configure the
Preferred NTP Server and Alternate NTP Server settings. If the
controller is installed in a closed network, configure the Preferred
Customer Server IP and Alternate Customer Server IP
settings.

*

Preferred NTP Server: Select an NTP server to provide
synchronization services to the controller. Make sure to use
an NTP server that is located close to where the controller is
installed to minimize propagation delays.

Alternate NTP Server: Select an alternate NTP server to
which the controller connects when it is unable to connect to
the preferred NTP server.

Preferred Customer Server IP: Select this option to use a
private NTP server if the controller is installed in a closed
network.

Alternate Customer Server IP: Select this option to set up a
substitute server if the controller is unable to connect to the
preferred server.

Adjust Time: Sets the interval at which the controller
synchronizes its clock with the assigned NTP server.

Sync: Click this button to save your configuration and start
synchronizing its clock with the assigned NTP server.

¢ Manually: Use the drop-down lists to set the controller’s time zone,
date, and time.
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Setting

Descriptions

Firmware

Displays the current firmware version of the controller and option
to upgrade/downgrade the firmware.

To upgrade/downgrade the firmware, click Update.

Important: Since the controller file system uses EXT2 for
firmware version 3.0 onward instead of FAT32 for prior versions,
downgrading a controller firmware from version 3.0 (or from any
later version) to a version prior to 3.0 will result in file formatting.
In this case, make sure to back up your project file before the
downgrade.

Select Check FW Version for the controller to check if the device
firmware is a later version than the browsed firmware file, and
display the result..
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Licenses for Mobile Control

A license is a software permit that an ATEN controller grants to a mobile
device for remote control. If you have three licenses for a controller, you can
have three mobile devices remotely operate the controller at the same time.

Note: When using an ATEN Touch Panel for remote control, make sure to
upgrade the controller to version 2.8 or later, which recognizes the
Touch Panel as an ATEN device and will not require a license.

Refer to the table below for the number of free licenses and the maximum
number of paid licenses each controller supports. To purchase additional
copies of license, contact your local sales representative.

ATEN Control Box
diteneen ATEN Control Pad
(VK0100 / VK0200)
VK1100 / VK2100 VK1200 / VK2200
No. of free licenses 2 2 0
Maximum no. of licenses 16 32 10

You can use the Licenses tab to:

+ Find out the total number of licenses, the number of licenses that are
available, and those that are in use

* Upload licenses to the ATEN controller

+ View license information

VK2100
E\TEN ATEN Controller o D

‘General Licenses Storage System Log Access Key Monitor Network Connections  Schedule

| Ut e |
#1 Aten iPad

#2 8320N-MIKET

Setting Description

Licenses ¢ In Use: displays the number of licenses being used by mobile
devices.

¢ Not in Use: displays the number of licenses available for use.

¢ Total shows the number of licenses purchased for the controller.

Update License | Clicking Add License opens the Add License window to import new
licenses to the controller.
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Setting Description

Remove When a device is accessing the controller, you can click the Remove
button to disconnect the session.

Storage

The Storage tab displays information about the space available for storing
Viewers on the controller.

E\TEN X'lls:lll.n(?antmller o E.

General Licenses Storage System Log Access Key Monitor Network Connections Schedule

Storage Existing Viewer

Available
e

All Rooms.

‘- ] bt

@ Remave.

Space Used 37KB
Space Available 251,587 KB

Total Space 251,624 KB

Setting Descriptions

Storage This section shows a graph displaying the percentage of space
available on the controller to upload Viewers, as well as:

* Space Used: The amount of space currently being used to store
Viewers uploaded to the controller.

# Space Available: The amount of space currently available to
store Viewers on the controller.

* Total Space: The total amount of space available to store
Viewers on the controller.

Existing Viewer This section lists all the Viewers that are currently stored on the
controller with their name and assigned room. Click Remove to
delete a single Viewer or Remove All to delete all Viewers from
the controller.
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Access

The Access tab allows you to configure the access key (password) of the ATEN
controller’s web interface and to set a validity period for accessing the ATEN
Control System using an activation key.

E\TEN Xg;‘gnmller o E’

General Licenses Storage System Log Access Monitor Network  Connections  Schedule Security

Access Key
Current Access Key
New Access Key

Confirm Access Key

Activation Key

® Your access to ATEN Control System will expire in (Il days.
Contact your system integrator to obtain the activation key required to regain access.

Activation Key

Confirm Activation Key

Setting Description

Access Key The access key is the password that is required to do the following:
¢ Log in the ATEN controller’s web interface.

¢ Upload projects and Viewers from Configurator to ATEN
controller (page 218).

Download Viewers from ATEN controller to mobile devices using
ATEN Control System App (page 280).

The following settings are available:

¢ Current Access Key, New Access Key, Confirm Access Key:
Use these three fields to set or change the access key. The
default access key is password.
IMPORTANT: You will be prompted to modify the access key
before you can continue with accessing the web GUI or
uploading project files.
Note: A valid password should only contain upper-case
alphabets, lower-case alphabets, and/or numerals.

¢ Show on dashboard: Select this option to show the access key
setting on the Dashboard tab.

¢ Enable Viewer Access Key: Select this option to request for the
access key when uploading projects and Viewers to the ATEN
controller or when downloading Viewers to mobile devices. Once
enabled, you can also configure this setting from the Dashboard
tab.
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Setting

Description

Activation Key

The activation key is a string of letters and numbers used to assign a
validity period of accessing the ATEN Control System.

To set up a validity period for accessing the ATEN Control System:

1.

Select Your access to ATEN Control System will expire in and
type the number of days.

Type an activation key. Follow the guidelines below when
creating your activation key:

¢ Max number of characters: 32

¢ Allowed characters: uppercase and lowercase letters,
numbers, and underscore

¢ Max. number of days: 999 days
Type the activation key again to confirm.

Click Save. The limit is immediately applied. For example:

Activation Key

Your access to ATEN Control System will expire in Gl days.

Contact your system integrator to obtain the activation key required to regain access.

Note: Keep the activation key somewhere secure because it
cannot be recovered. In case you forget the activation key, press
the reset button/switch for 8 seconds to set the ATEN controller
to default. This will reset all configuration of the controller to
default and remove any projects and Viewers stored on the ATEN
controller.

To disable the validity period, click Enter Activation Key to type the
activation key provided by the system integrator.
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Monitor

The Monitor tab allows you to view and enable the monitors that have been
configured for Flags and digital input devices in ATEN Configurator. Check
the Show on dashboard box to show the Monitor settings on the Dashboard.
Click the slide bar next to the monitor you want to enable or use the drop-down
menu to select All On or All Off.

E\TEN x::rll.n(?ontmller o E’

General Licenses Storage System Log Access Key Monitor Network Connections Schedule

Monitor

For more information about creating monitors, see Library, page 178.
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Network

The Network tab allows you to view and configure the controller’s network
settings. Select Manually to set a static /P Address, Subnet Mask, and Default
Gateway, or Use DHCP to have the server assign an IP address to the
controller.

Note: Make sure to set the ATEN controller’s IP address and Default Gateway
to the same subnet.

General Licenses Storage  SystemLog  AccessKey  Monitor Network | Connections | Schedule

Network

Get IP Address ® Manually
© Use DHGP

1P Address
Subnet Mask

Default Gateway

Get DNS Server © Automatically
®Manually
Preferred DNS Server

Alternate DNS Server

Working as a DHCP Server

For VK1200 / VK2200 only, the control box can operate as a DHCP
server for automated assigning dynamic IP addresses to all of the LAN
devices managed via its Control LAN. To do this, follow the steps below.:

Control LAN

Get IP Address Enable DHCP Server v
IP Address 10.3.41.149

Subnet Mask 255.255.255.0

Default Gateway 10.3.41.254

IP Assigned Range 192.168.061 [l 192.168.0.254

Lease Time (sec.) 7200

1. From the Get IP Address drop-down list, select Enable DHCP Server,
and optionally change the network settings of the ATEN Control
System, namely IP address, subnet mask, and default gateway.

2. Next to IP Assigned Range, define the desired range of IP that can be
used for assigning IP addresses to the connecting IP devices.

3. Next to Lease Time, define the amount of time an assigned IP address
becomes available for use after the IP device it is previously assigned
to has been inactive for.
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Connections

The Connections tab allows you to view the connection statuses and IP
addresses of licensed devices, ATEN Keypads, and ATEN Expansion Boxes.

VK2100
ATEN Controller

ATEN

Licenses Storage System Log Access Key
Licensed Devices and Keypads
Name

8320N-MIKET

8060P-CHRISTINE

Expansion Box

or

Monitor Network Connections | Schedule

IP Address
N/A

N/A

IP Address
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Schedule

The Schedule tab lists scheduled events predefined using the ATEN
Configurator. You can use this tab to do the following:

+ Enable or disable scheduled events.

+ Enable or disable scheduled days

For details on setting up scheduled events, see Scheduled Events, page 202.

VK2100
ATEN Controller c E'

Licenses Storage System Log Access Key i Network Connections Schedule

Schedule Event
Name

[} OPEN Sunday
@ Monday
Tuesday
Wendesday [08
Thursday
@ Friday 100:00
Saturday  [00:00

[ ] CLOSE Sunday 1€
Monday
@ Tuesday
Wendesday
Thursday
= Friday 00

= Saturday  [00:00
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Security

The Security tab allows you to configure SSL and TSL settings to secure the
browsing sessions between your computer and the ATEN controller’s web
interface.

*

SSL Certificate: To enable SSL encryption on the controller, purchase
and obtain an SSL certificate from a trusted certifying authority and click
Upload to apply the certificate.

TLS Support: Each ATEN controller supports TLS 1.0, 1.1, and 1.2to
allow communications with devices supporting different versions of the
TLS. If you have any security concerns, disable the Enable TLS 1.0 and
TLS 1.1 setting to only allow communications among devices that support
TLS 1.2 and click Save.

ATEN | 1\ Controter (< Cs

General | Licenses Storage  SystemLog | AccessKey  Monitor Network | Connections = Schedule  Security

SSL Certificate

LS Support

¥ Enable TLS 1.0and TLS 1.1
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Chapter 4
ATEN Configurator (VK6000)

Overview

The ATEN Configurator (VK6000) is a GUI-based management tool that helps
you set up and configure the connected hardware and create control interfaces
to be used by mobile devices and ATEN Keypads.

Installation

To install the ATEN Configurator software, do the following:
1. Download ATEN Configurator.

a) Visit the ATEN download page.
http://www.aten.com/global/en/support-and-downloads/downloads/

b) Search for “VK6000”. A list of downloads for VK6000 appear.

c) Click ATEN_configurator_software_x.x.xxx.zip to download.

2. Open the downloaded zip file and double-click
ATEN_configurator_software_x.x.xxx.exe to run the setup. This screen
appears.

VK6000 - InstallShield Wizard (==
Welcome to the InstallShield Wizard for YKE000

The InstallShield \wizard will install VEEBDDD on your
computer. To continue, click Mext.

<Back | Mest> |[ Cancel
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3. Click Next. This screen appears.

VKB000 - InstallShield Wizard

License Agreement

Pleaze read the following license agreement carefully.

Software End User License Agreement -

You may use our software and services only on the condition that you
agree to abide by the following terms. We sincerely recommend that
vou shall read this Agreement very carefully.

BY DOWNLOADING, INSTALLING OR USING OUR
SOFTWARE, YOU ARE AGREEING ELECTRONICALLY TO

TTTR TTEDMAAC AT TIITC CATTIITADT TR TTOTN T TeTmaIeT

() | accept the terms of the license agresment

@ | do not accept the terms of the license agreement

4. If you agree with the License Agreement, select I accept the terms of the
license agreement, and click Next. Click Print to print the Software End
User License Agreement. This screen appears.

VKB000 - InstallShield Wizard |
Choose Destination Location ﬂ
Select folder where setup will install files. =

&

G Install VEEOO0 to:
C:vProgram Files'ATEMYWKE000

[ < Back ][ Mest » ][ Cancel
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To change the destination location, click Change. Click Next to proceed
using the default location. This screen appears.

VKB00O - InstallShield Wizard

Ready to Install the Program
The wizard iz ready to begin installation.

Click Install to begin the installation.

If you want ta review or change any of your installation settings, click Back. Click Cancel to exit
the wizard.

Inztall5 hield

[ < Back ][ Inztall ][ Cancel ]

Click Install. When the process is complete, a confirmation message
appears.

VKB000 - InstallShield Wizard

InstallShield Wizard Complete

The InstallShield Wizard haz successfully installed YKE000,
Click Finish to exit the wizard.

< Back Cancel

Click Finish.
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Getting Started Tasks

After you have installed and launched the ATEN Configurator, the main screen
(page 92) appears. You will be guided to create and configure a project using
the 4 tabs in the Configurator’s interface, as illustrated below.

1. Project 2. Device *‘ 3. Design i( 4 Upload g

Hint: You can click the tabs to switch among different pages for configuration.

The steps below provides an overview of the getting started tasks.

1. In the Project tab, do the following.
¢ Provide information about the ATEN controller that you have set up.

+ (Optional) Provide client information for the specified ATEN
controller.

¢ Click Add Controller if you have more than one controller in the
environment.

For more details, see The menu bar contains the Configurator’s main
functions arranged by category. Refer to the table below to find out what
each function does., page 93.

Click Start Project to proceed.

2. In the Device tab, do the following.

¢ Connect each controller with its managed devices by adding them to
the controller’s Device Configuration list, enter the connection
settings, and specify the physical locations.

¢ (Optional) Add another controller and/or Expansion Box to the project
by clicking Add Controller or Expander.

+ Connect the Expansion Box with its managed devices by adding them
to the Expansion Box’s Device Configuration list.

For more details, see Configuring Managed Devices, page 102.
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Click Design or the Viewer tab to proceed.

I&ATEN Configurator - [Untitled Project.vkproj*]

File Edit View Object Tools Windows Help

. iew  ae——

1. Project B 2 Device *) 3. Design o 4 Upload g

< VK2200-IDO1 X
Controll..m Unizon

[} VK2200-1D01 ‘ Device Configuration

. In the Design tab, do the following.

¢ Create and configure a control interface (Viewer). For more
information, see Configuring Control Interfaces, page 120.

+ (Optional) Set up scheduled events to automatically carry out specified
actions.

¢ (Optional) Add additional conditions and actions to buttons using
Flags. For details, see Flag, page 179.

+ (Optional) Create a sequence of actions for a button by creating a
Macro. For details, see Macro, page 200.

¢ (Optional) Create a Variable for a device setting that is controlled by
two or more objects in one control interface. For details, see Variables,
page 203.

. In the Upload tab, upload this Viewer to the controller. For details, see The
Upload Tab, page 218.
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Main Screen

Overview

Double-click the Configurator.exe shortcut to open the ATEN Configurator
software. The Project page appears:

[ ATEN Conigummr- o

[

ContollerID.

ATEN Conroller Type

Number of Room(s)

D1

V2100 =

No. Control Description

1 | Menu Bar The menu bar contains a group of the Configurator ‘s main
functions by category. For details, see Menu Bar, page 93.

2 | Project Bar The Project Bar contains four tab and the Library icon. Each
tab relates to a step required to set up the project. Each
step and the Library can be selected by clicking on the bar.

3 | Interactive Display | This is the main work area. The page that appears here

Panel reflects the project tab that is selected.

4 | Library The Library contains the devices, graphic, flag, macro, and
monitor databases. Each section allows you to add custom
items or choose from ready made selections.

5 | Toggle Bar These three icons are used as a toggle to show or hide the

right, left and bottom control panel.
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No.

Control

Description

6 | Simulator

the page links.

The Simulator button is used to test the Viewer after it is
created in Design. The simulator allows you to tryout the
interface as it would work on a mobile device but without
actually controlling devices. Use the mouse to click through

Menu Bar

The menu bar contains the Configurator’s main functions arranged by
category. Refer to the table below to find out what each function does.

Menu

Sub-Menu

Description

File

New Project

Select to create a new project.

Open Project

Select to browse and open a previously
saved project.

Restore Project from Controller

Downloads a previously backed up
project from a controller.

Close Closes the current project and returns to
the Project tab.

Save Select to save changes to the current
project.

Save as Use this option to save the project as a

different name.

Export Viewer to USB

(Not supported by ATEN Control
Pad)

Exports Viewers and an access key to a
USB drive. After exporting the data onto
a USB drive, plug the USB drive into the
Control Box’s USB port to upload the
Viewer files and the access key. These
files can only be read by the Control Box
and are not project files that can be
opened by the ATEN Configurator
software.

Project Report

Click to save a PDF file that contains
detailed information about each part of
the current project.

Import ETS Project

Import an ETS project file for your KNX
devices.

Recent Projects

Select to view a list of recent projects that
can be clicked on to open.

Exit

Select to close the project and exit.
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Menu Sub-Menu Description
Edit Undo Select to undo a change when editing a
Viewer in Create & Design Viewer.
Redo Select to redo a change when editing a
Viewer page in Create & Design Viewer.
Cut/Copy/Paste Select to cut, copy or paste text and

objects when editing a Viewer page in
Create & Design Viewer. When used to
copy and paste a button, both the
General and Action properties are
copied.

Paste Graphic Only

Select to paste a button’s image but not
its Action properties in Create & Design
Viewer.

Delete

Select to delete highlighted text and
images when editing a page in Create &
Design Viewer.

Delete Action Only

Select to delete the Action properties of a
button in Create & Design Viewer.

Select All / Deselect All

Use either option to select or unselect all
objects when editing a viewer page in
Create & Design Viewer.

Preferences Display
Language

Use to select the language for the
interface.

SSH
Destination

Click to choose the location of the
executable for the SSH Client software.
To execute the program, go to Tools >
SSH Client.

Interface

Check a box to enable the feature

described below:

¢ Show Welcome Page: displays the
Welcome screen when the ATEN Con-
figurator software opens.

¢ Auto Page Creation: automatically
creates a Viewer page in Create
Viewer & Design, for every hardware
device that is configured in Select
Device & Configuration.

¢ Show Password: displays the charac-
ters of the access key in the Edit
Access Key dialog box.

¢ Automatically check for updates:
automatically checks for updates and
notify the user when an update is
available.

94



Chapter 4. ATEN Configurator (VK6000)

Menu

Sub-Menu

Description

View

These options are available from Create Viewer & Design Edit Viewer.

Zoom

Zooms the Viewer page to 25%, 50%,
75%, 100%, 200% or Fit in Window.
Note: A mouse wheel can be used to
zoom the Viewer page in or out.

Project Information

Select to go to Project Information.

Device Configuration

Select to go to Select Device &
Configuration.

Viewer Design

Select to go to Create Viewer & Design.

Project Upload

Select to go to Search & Upload.

Properties

Select to show/hide the Properties
window when editing a Viewer page.

Align to Grid

Select to automatically align objects with
the grid. This places objects in perfect
alignment with the grid dots when they
are moved. Use Show Grid to display the
grid dots. When Align to Grid is not
selected, objects can be placed
anywhere on the page.

Show Grid

Select to display the grid dots on the
page. Use with the Align to Grid option to
set objects in perfect alignment on the
page.

Show Object ID

Select to show object ID at the top-right
corner of each object. An object ID is
used to specify an object in some
configuration.
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Menu

Sub-Menu

Description

Object

These options are available from Create Viewer & Design Edit Viewer.

Button Adds a button to the Viewer page.

Text Adds a text box to the Viewer page.

Image Adds an image to the Viewer page.

Scroll View Adds a scroll box to the Viewer page,
then double-click it to add buttons. Use
the box as a scroll window to easily
access a list of buttons on the page.

Video Adds a video box which allows you to
view video. The video box can be resized
using the Properties sidebar or by
dragging a small box on the boarder to
resize it to the desired shape.

Slider Bar Adds a slider bar to the Viewer page.

Slider bars are used to adjust the value
of a device setting, such as the volume
level of an audio device.
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Menu

Sub-Menu

Description

Object

PowerPoint Control Template

Adds a PowerPoint Control template to
the Viewer. This control template is used
to control PowerPoint files saved in a
target computer.

Media Control Template

Adds a Media Control template to the
Viewer. This control template is used to
control media files saved in a target
computer.

Line Adds a line to visually separate objects
on the Viewer.
Frame Adds a frame to visually frame an object
or to group a set of objects in the Viewer.
Dial Kit Adds a dial kit to the Viewer. The dial kit
can be used for dialing a meeting.
Group Group Select multiple objects and use Group to
lock them together. Objects in the group
will move together as one.
Radio Select multiple buttons and use Radio
Group Group to associate them as follows:
selecting a button that belongs to the
radio group deselects the previously
selected radio button within the same
group.
Ungroup Select grouped objects and use
Ungroup to unlock the group.
Order Bring to Moves an object to the top position when
Front objects are layered.
Send to Moves an object to the bottom position
Back when objects are layered.
Bring Moves an object up one position when
Forward objects are layered.
Send Moves an object down one position when
Backward | objects are layered.
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Menu

Sub-Menu

Description

Object

Align

Left

Aligns two or more selected objects to
the Left side of the object that is selected
last.

Center

Aligns two or more selected objects to
the horizontal position of the object that
is selected last.

Right

Aligns two or more selected objects to
the Right side of the object that is
selected last.

Top

Aligns two or more selected objects to
the Top side of the object that is selected
last.

Middle

Aligns two or more selected objects to
the vertical position of the object that is
selected last.

Bottom

Aligns two or more selected objects to
the Bottom side of the object that is
selected last.

Make Same Size | Width Resizes two or more selected objects to
the same width of the object that is
selected last.

Height Resizes two or more selected objects to
the same height of the object that is
selected last.

Both Resizes two or more selected objects to
the same width and height of the object
that is selected last.

Space Evenly Across Spaces two or more selected objects
Page Width | evenly across the width of the page.
Across Spaces two or more selected objects
Page evenly across the height of the page.
Height
Between Adjusts the horizontal space between
Objects three or more selected objects to the
Horizontally | average distance between each of the

selected objects.

Between Adjusts the vertical space between three

Objects or more selected objects to the average

Vertically distance between each of the selected

objects.
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Menu

Sub-Menu

Description

Tools

Database Generator

Opens the ATEN Database Generator
which is used to manually add and
configure hardware devices. This is
where you can create custom devices to
add to My Device Library. See ATEN
Database Generator, page 223, for
details.

Simulator

The Simulator is used to test a Viewer’s
interface after it has been created in
Design. The simulator allows you to
tryout the interface as it would work on a
mobile device but without actually
controlling devices. Use the mouse to
click through the page links.

SSH Client

This runs the SSH Client software
selected under Edit > Preferences >SSH
Destination. The SSH Client is used to
communicate with the controller.

Windows

New Page

Click to create a new Viewer page or
select a page to open in Create Viewer &
Design.

Help

About

Provides the firmware version and
support information for the Configurator
software.

Check for Updates

Checks if ATEN Configurator is up-to-
date.
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Creating Projects

The Project tab allows you to enter details about the installation to start the
project. Enter the information using the table below as a guide.

Controlier IO

ATEN Canroler Typs

Mambe of Roomis)

o1

Control Description
Name Enter the project name you are setting up. You can create

multiple projects but for most installations only one project is
required.

Add Controller

Click to add controllers to the project. The number added
should match the number of controllers installed. A project can
have up to 16 controllers.

Controller ID

Displays the Control Box ID. Make sure to set the Control Box
ID Switch on the rear of the Control Box using the ID displayed
here so that the project file will be uploaded to the controller set
with the same ID.

ATEN Controller Type

Select the controller model you are installing.
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Control

Description

Number of Rooms

Enter the number of rooms each controller will control. Each
hardware device you add will be associated with a room. When
buttons are configured in the Design tab, you can select a
Room under Button Action to filter the Device list so that only
hardware in that room appears. This link between the
controller, devices and room is how the Viewer knows which
devices to control.

Name Enter the client name associated with the project.
Address Enter the client address associated with the project.
Phone Enter the client phone number associated with the project.

Remove Controller

Click to delete a controller from the project.

Start Project

Click to begin configuring hardware devices. The Select Device
& Configuration tab will open.
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Configuring Managed Devices

Overview

The Device tab is used to configure controller ports according to the connected
hardware device.

LY ATEN Configurator

= U] Device Configuration e
o V21001001 naeice ||
Room-4 Type Device Mode Room Unizon @
Room5 Serial 1 1 None Rs232 Room1 |
Serial 2 I None Rs232 Room1 | ] Category
Serial3 | None Rs232 | Room1 ] o
Serale | None sz e Room1 | m Bend
Serial 5 1 None Rs232 =l Room1 7| ] Model
Serial 6 I None Rs232 =l Room1 | ]
o1 1 Nore Ouput - Room1 ] ] = ==
o2 1 None Ouput E Room1 =] 0
03 I None ouput -l Room1 7] D P——
o4 1 None Output E] Room1 <] ] Baud Rate
"1 I Nore = g Rooms [f] i [ =
2 I Nons [ -l Room1 <] 0 e -]
R3 1 Nore R e Room1 | o .
R4 1 ore R = Room1 X T
Relay 1 1 None Room1 = ] b= =
Relay 2 I None Room1 | [
Rolay3 | None Room1 ] 0
Retays | None Room1 7] ]
Ethemet1 | None Room1 7| ]
Control Description
Device This section lists the ports for each controller, their connected device,
Configuration | connection mode, device location (room) and if the device is managed
List by Unizon™. Clickon a controller, expansion box or Room in the left

sidebar to display the ports. Each port needs to be configured
according to the hardware device connected to it. For details, see Left
Sidebar, page 103.

Left Sidebar The left sidebar provides a tree view of the ATEN Control System
deployment in each project. Use the sidebar to add/remove a
controller, Expansion Box, or Room.

Properties This section allows you to add and configure controllers, Expansion
Boxes, managed devices, and rooms. For details, see Configuring
Control Interfaces, page 120.
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Control

Description

Device Library | Click this icon to open the Library on the Device Library tab which

contains a database of hardware devices that can be added to the
Device Configuration list. For details, see Device Library, page 119.

Left Sidebar

Controll... Viewer ...

—-VK2100-1D01

- VK236-D01
- VK248-1D01
- VK258-1D01
=-Room-1
- VES8950
--VES300
--\VM0808H
- Switch
- VS481A
.. Switch-1
VMI1616T
- VK2200-ID02
=-Room-2
--VEB8950-1

Unizon

Controller

The Left Sidebar provides a tree view of the
controllers, Expansion Boxes, and rooms.
Each controller in the tree view represents a
controller with one or more rooms it manages.
Selecting a controller allows you to configure
its ports. When a port is configured for a
device, it appears listed under the Room.

Each controller must have at least one room.
When installing multiple controllers in one
room, add a room with the same name to each
controller.

Each controller name ends with an ID number:
VK2100-ID01. Use this number to set the
Controller ID Switch on the rear of the
controller. This links the controller in the
software to the physical device being installed.

Right-click a controller to Add Room or Delete
Controller.

Room

Each room is associated with a controller and
a Viewer so that the information is uploaded to
the correct controller to control the hardware
devices. Right click a room to Delete or
Rename the room. Use the buttons at the
bottom of the sidebar to Add Room.

Expansion Box

ATEN Expansion Boxes connect over a
network to add ports to the controller via its
Ethernet port. Clicking Add Controller or
Expander opens a window which allows you
to select a device to add.
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Device Configuration List

The Device Configuration page lists the controller ports by type. Click a port
to view its Properties. Double-click a port to open the ATEN Device Library
and search for the hardware device to configure the port. Configure each port
according to the hardware device connected to it.

- VK2100-1DOL X

Device Configuration
VK2100-1DO1
Type Device Mode Room Unizon @
Serial 1 I None RS232 Room-1 | [
Serial 2 I None RS232 Room-1 | [
Serial 3 1 None RS232 | Room-1 x| [
Serial 4 1l None RS232 | Room-1 | ]
Serial 5 1 None RS232 -l Room-1 x| [
Serial 6 1 None RS232 E Room-1  ~| [
o1 Il None Output =l Room-1 Jhd| ]
o2 1 None Output -l Room-1 x| [
103 1 None Output = Room-1  ~| [
yo 4 Il None Output | Room-1 | ]
R1 I None IR | Room-1 1= [ +Add More Devices
IR2 Il None IR El Room-1 1=l ] + Add More Devices
R3 Il None IR | Room-1 1= [ +Add More Devices
R4 I None IR E Room-1 =l [ + Add More Devices
Relay 1 1 None Room-1 =] [
Relay 2 1 None Room-1 =] [
Relay 3 1l None Room-1 | ]
Relay 4 1l None Roem-1 = ]
Etheret 1 Il None Room-1 =l ] + Add More Devices
VK224-1D01
Type Device Mode Room Unizon
Serial 1 I None RS232 - Room-1 | [
Serial 2 1 None RS232 El Room-1 x| ]
Serial 3 1l None RS232 | Room-1 | [
Serial 4 1 None RS232 E Room-1  ~| [
VK248-1D01
Type Device Mode Room Unizon
Relay 1 Il None Roem-1 | [
Relay 2 1 None Room-1 =] [
Relay 3 ! None Room-1 | E
Control Description
Type Lists the ports of the controller.
Device Lists the device name entered in Properties.
Mode Lists the port’s communication mode. Click an arrow to select options:
¢ Serial: RS232, RS422, or RS485
¢ 1/O: Input (VDC), Input (Dry Contact) or Output
¢ |IR: IR or RS232
Room Lists the room selected for a device. The rooms available depend on the
number of rooms added to the controller. No drop-down menu appears
if there is only one room. Each controller must have at least one room.
Select the room where the device is installed.
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Control Description

Unizon™ Select this option to allow Unizon™ to manage and monitor the
corresponding device.
Note: Configuration will also be required on Unizon™ for this feature to
work. For an overview of how to set up the function, see Centralized
Monitoring and Control via Unizon™, page 210.

+ Add More | RS422, RS485, LAN and IR ports can cascade additional devices that

Devices are connected to the first unit. IR ports can cascade 1 device, RS422

and RS485 ports can cascade up to 2 devices and LAN ports can
cascade up to 25 devices.
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Adding Devices to the Device Configuration List

Adding Non-KNX-Compliant Devices to ATEN Configurator

To add devices that are not KNX compliant, use one of the following methods.

Via ATEN Device Library or My Library

1. In the Device Configuration list, click a port where you have physically
installed a device.

VK2200-1001 X | VK2100-1D02. |

Device Configuration
VK22004D01
Type Device Mode Room Unizon @
| |
Serial 2 None RS232 Room-1 |
Serial 3 None RS232 Room-1 !_
Serial 4 None RS232 Room-1 [
Serial 5 None RS232 Room-1 !_

2. Click E library. In the pop-up window, click the drop-down list to select
ATEN Device Library or My Device Library, and then double-click an item
to add the device. The selected device is added to Device Configuration.

VK2200-1D01 X | VK2100-1D02 |

Device Configuration
VK2200-1D01
Type Device Mode Room Unizon ©
Benal 2 Tone 35 Toom T f
Serial 3 None RS232 Room-1 [
Serial 4 None Rs232 Room-1 r
Serial 5 None RS232 Room-1 [
Serial 6 None Rs232 Room-1 r
. .. e 1 -~ . =
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Via the Properties Column

In the Device Configuration list, click a port where you have physically
installed a device.

VK2200-1001 X | VK2200-ID02. |

Device Configuration

VK2200-1D01
Type Device Mode Room Unizon @
1 | |
Serial 2 I None RS232 Room-1 [
Serial 3 | None RS232 Room-1 [
Serial 4 I None RS232 Room-1 [
Serial 5 | None RS232 Room-1 [

2. Use one of the following to add a device.

+ Select from Library:
Use this method to automatically bring in default settings for the
selected device.

(a) Click the arrow button and select Add device from the Library to
open the Library.

Add device from the Library

(b) Click the drop-down list to select ATEN Device Library or My
Device Library, and then double-click an item to add the device.

Specify and configure settings

Use this method to type and configure each setting for the device.
When the configuration is complete, click Add Device.

Name

-
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Note:

If the device is not in the Library, create the device using Database
Generator. For details, see Editing / Adding a New Device, page 230.

ATEN Device Library vl

ATEN Device Library
My Device Library

- Version Property
Create Device
ATET [ [=To o voa08H V22219

ATEN  Video Matric Switch ~ VMOS03 V1.1.106

Adding KNX-compliant Devices to ATEN Configurator

1. Click File and then Import ETS Project. The configurations for your
KNX devices appear in the Controller tab on the left-side bar.

2. In the Controller tab, click on KNX IP Interface and type its [P address
and port in the Properties column.
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Device Properties

The Properties panel provides information and configuration fields for
controllers, Expansion Boxes, remote devices, or rooms. Click a device or room
from the left sidebar or the Device Configuration list to display its properties.

Controller Properties

Click a controller from the left sidebar or from
the Device Configuration list to configure or
Name view the following properties.

M0 +Name: Displays the device model.

+Controller ID: Sets the controller ID. ATEN
Expansion Box and Keypad will connect to a

o N P E— controller with a matching controller ID as set
on the Expansion Box or Keypad using the
Brand  ATEN Controller ID Switch.

Identify ATEM Extension Boxes and
Keypads by IF address

Port 43520

+ Identify ATEN Expansion Box and Keypad by IP Address

Enable this function for the controller to connect to ATEN Expansion Box or
Keypad by identifying their IP addresses. Use this function if any of the
following scenarios applies:

+ When you have more than 16 controllers under the same subnet, in
which case you would have at least one controller using the same ID.

* When your network switch blocks multicast signals between the
controller and the Expansion Box / Keypad.

To use this function, make sure to do the following.

¢ On the Expansion Box/Keypad:

¢ Set the controller ID using the Controller ID Switch. When you
have more than 16 controllers under a subnet, at least two of the
Expansion Boxes and/or Keypads will be assigned with the same
controller ID.

+ Set the Expansion Box/Keypad to a fixed IP address.

* In the project files:
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+ |n the Devices tab, make sure the controller IDs match the
configuration on the Expansion Boxes and/or Keypads.

+ In the Devices tab, enable the Identify ATEN Expansion Boxes
and Keypads by IP address function the Properties panel. For
example, if you have 17 controllers set up under the same subnet,
with controller 1 and 17 using ID01, enable the function for both of
these controllers.

+ Specify the IP address of the Expansion Box/Keypad.
For Keypad, go to Design > Viewer Settings.

/" Viewer Settings X

Select Viewer

( ) Mabile Device 0 Keypad

Model |VKI0BUS -
Layout |Typel -

Controller ID | VK2100-D01 -

Keypad ID | VKI108US-IDO1 = I I

For Expansion Box, go to Devices and find the Properties panel.

£
H

Name

VK224

Brand pten

Connection Setting

IP Address
Optional

+ Port: Specify the port to allow TCP communications from third-party client
devices.
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Expansion Box (Expander)

Click an expansion box from the left sidebar or from the Device Configuration
list to configure or view the following properties

Name

VK224

Expander 1D D01 -

Brand | ATEN

Connection Settings

IP Address
Optional

¢ Name: Displays the device model.
+ Expander ID: Select the expander ID. Make sure the ID matches the one
set physically on the Expansion Box.

¢ [IP Address: Only specify the IP address of the expansion box when the
Identify ATEN Expansion Box and Keypad by IP Address setting is
enabled.

111



ATEN Control System User Manual

Serial Device Properties

Name

VM1600

Remove

Category  Video Matrix Switches
Brand ATEN

Model  ym1600

Version [y13125 «|[=
Connection Settings

BaudRate
13200 -
DataBit
B~
1 -
MNone hd

Stop Bit

Parity

Delay Interval

1] w | Seconds

Feedback Timsout

0.1 w | Seconds

Keep Connection Alive
Format [@ASCH  (T)HEX

Command

Interval

10 Seconds (1.0760.0)

Click a serial device from the Device
Configuration list to configure its
properties.

*Name: Displays the device model.

+*Add Device: Use this button to add
devices. For details, see Adding Non-
KNX-Compliant Devices to ATEN
Configurator, page 106.

+Category: Displays the category of the
selected device.

+Brand: Displays the brand of the
selected device.

*Model: Displays the model of the
selected device.

+Version: Shows the firmware version
selected for the device. Use the drop-
down menu to select a different firmware
version. Click the menu box next to the
version number to open a PDF with the
version history. The version history and
different versions for a device can be
manually added/updated via the Database
Generator (see step 3 of Editing / Adding
a New Device, page 230).

+Connection Settings: Click the drop-
down lists to configure the baud rate, data
bit, stop bit, parity settings, and flow
control for the selected serial device.
+Advance Settings: Click Advanced to
display the following settings.

+Delay Interval: Sets a time delay for
each command before they are sent to the
device.

*Feedback Timeout: Sets the maximum
interval that the controller allows in

112



Chapter 4. ATEN Configurator (VK6000)

between parts of a feedback message. The controller uses this value to
identify the end of a message.

Keep Connection Alive: The controller sends a command to the serial
device to maintain the connection and avoid timeout issues.

+ Command: Type a command to be sent to the selected device.

+ Interval: Type the interval at which the controller sends the
command.
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/0 Device Properties

MName

Switch-1

Remove

Category  Switch
Brand  Syitch

Model  Suitch

Version |y1 g —

Delay Interval

0 w | Seconds

Click an I/0 device from the Device
Configuration list and select Input
(VDC), Input (Dry Contact), or Output
to configure its properties.

+*Name: Displays the device model.

+*Add Device: Use this button to add
devices. For details, see Adding Non-
KNX-Compliant Devices to ATEN
Configurator, page 106.

+Category: Displays the category of
the selected device.

*Brand: Displays the brand of the
selected device.

+Model: Displays the model of the
selected device.

+Version: Shows the firmware version
selected for the device. Use the drop-
down menu to select a different
firmware version. Click the menu box
next to the version number to open a
PDF with the version history. The

version history and different versions for a device can be manually added/
updated via the Database Generator (see step 3 of Editing / Adding a New

Device, page 230).

¢+ Lower Threshold & Upper Threshold: Set the thresholds according to the
hardware device you are connecting and then configure a Monitor (see

page 181).

+ Advance Settings: Click Advanced to display the Delay Interval setting.

+ Delay Interval: Sets a time delay for each command before they are

sent to the device.
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IR/Relay Device Properties

Mame

V54814

Remove

Category  Video Switches
Brand ATEN

Model 54814

Version [yap195 w|/=

Delay Interval

1] w | Seconds

Click an IR/Relay device from the Device
Configuration list to configure its
properties.

*Name: Displays the device model.

+Add Device: Use this button to add
devices. For details, see Adding Non-
KNX-Compliant Devices to ATEN
Configurator, page 106.Category:
Displays the category of the selected
device.

+Brand: Displays the brand of the
selected device.

*Model: Displays the model of the
selected device.

*Version: Shows the firmware version
selected for the device. Use the drop-
down menu to select a different firmware
version. Click the menu box next to the
version number to open a PDF with the
version history. The version history and
different versions for a device can be

manually added/updated via the Database Generator (see step 3 of Editing
/ Adding a New Device, page 230).

+ Advance Settings: Click Advanced to display the Delay Interval setting.

+ Delay Interval: Sets a time delay for each command before they are

sent to the device.
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Ethernet Device Properties

Name

Control Assist

Remove

Category  Toal
Brand ATEN

Model  CortrolAssist
Version [y1 2 - | =

Connection Settings

Protocal Type
HTTPS hd

IP Address
10.3.41.121

Part
6277

Usemame
administrator

Paszword

Delay Interval

1] w | Seconds

Click an Ethernet device to configure its
properties. Each Control Box supports up
to 25 Ethernet devices, and each Control
Pad supports up to 8.

+*Name: Displays the device model.
+Add Device: Use this button to add
devices. For details, see Adding Non-
KNX-Compliant Devices to ATEN
Configurator, page 106.

+Category: Displays the category of the
selected device.

*Brand: Displays the brand of the
selected device.

*Model: Displays the model of the
selected device.

+Version: Shows the firmware version
selected for the device. Use the drop-
down menu to select a different firmware
version. Click the menu box next to the
version number to open a PDF with the
version history. The version history and
different versions for a device can be
manually added/updated via the
Database Generator (see step 3 of
Editing / Adding a New Device,

page 230).

+Connection Settings

Depending on the selected protocol,
some of the following settings may not
be required and are not displayed.

+*Protocol Type: Click to select the
protocol for the Ethernet device. The

ATEN Control System supports control of devices via telnet, ONVIF,

TCP, UDP, HTTP, and HTTPS.

+ |P Address: Type to assign a fixed IP address to the Ethernet device.

+ Port: Type to assign a communication port.

+ Username & Password: Type the device’s login/access credentials.
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*

VE Manager Password: Type the administrator password of the

VE Manager to allow the controller to access video sources connected
to the video extenders managed by the VE Manager.

Note: This setting is only applicable to ATEN networked video
extenders.

Auth Type: Sets the authentication type that the device uses.

Check Status (ICMP): Select this option to allow the controller to send
control messages to receive connection status for this Ethernet device.
Note: To allow the online/offline status to be accessible to Unizon™

for remote management, select the Unizon™ checkbox that
corresponds to the device in the Device Configuration list.

+ Advance Settings: Click Advanced to display the Delay Interval setting.

*

Delay Interval: Sets a time delay for each command before they are
sent to the device.

Delay after Login (for telnet only): Sets a delay (to allow a connection
to be established) before the First and Second Commands are sent to
the device.

Send command after connection (for telnet and TCP only): Sends
commands to the device after a successful connection has been
established.

+ Format: Sets the command format.
¢ First Command: Sets the command.
¢+ Second Command: Sets the second command.

+ Automatically reconnect if no return message is received:
Select this option to continue reconnection attempts when no
return message is received from the device.

Keep Connection Alive (for telnet and TCP only): The controller
sends a command to the device to maintain the connection and avoid
timeout issues.

+ Command: Type a command to be sent to the selected device.

+ Interval: Type the interval at which the controller sends the
command.
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pum Library

E=8 The Project Bar provides the Library option. Use the Device Library
tab (shown below) to configure controller ports according to the
connected hardware devices. The Device Library provides an extensive
database of hardware devices that can be double-clicked or drag and dropped
into the Device Configuration page to configure controller ports. The Device

Library is discussed on the next page.

ATEN Device Library

vI

Brand

ATEN
ATEN
ATEN
ATEN
ATEN
ATEN
ATEN
ATEN
ATEN
ATEN
ATEN
ATEN
ATEN
ATEN
ATEN
ATEN
ATEN
ATEN
ATEN

Video Matrix Switch
Video Matrix Switch
Video Matrix Switch
Video Matrix Switch
Video Matrix Switch
Video Matrix Switch
Video Matrix Switch
Video Matrix Switch
Video Matrix Switch
Video Matrix Switch
Video Matrix Switch
Video Matrix Switch
Vid